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Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user's guide describes the General Motor Control Library (GMCLIB) for the family of ARM Cortex M33F core-based
microcontrollers. This library contains optimized functions.

1.1.2 Data types

GMCLIB supports several data types: (un)signed integer, fractional , and accumulator, and floating point. The integer data types
are useful for general-purpose computation; they are familiar to the MPU and MCU programmers. The fractional data types enable
powerful numeric and digital-signal-processing algorithms to be implemented. The accumulator data type is a combination of
both; that means it has the integer and fractional portions. The floating-point data types are capable of storing real numbers in
wide dynamic ranges. The type is represented by binary digits and an exponent. The exponent allows scaling the numbers from
extremely small to extremely big numbers. Because the exponent takes part of the type, the overall resolution of the number is
reduced when compared to the fixed-point type of the same size.

The following list shows the integer types defined in the libraries:

* Unsigned 16-bit integer—<0 ; 65535> with the minimum resolution of 1

» Signed 16-bit integer—<-32768 ; 32767> with the minimum resolution of 1

* Unsigned 32-bit integer—<0 ; 4294967295> with the minimum resolution of 1

» Signed 32-bit integer—<-2147483648 ; 2147483647> with the minimum resolution of 1
The following list shows the fractional types defined in the libraries:

+ Fixed-point 16-bit fractional—<-1 ; 1 - 2-15> with the minimum resolution of 2-15

+ Fixed-point 32-bit fractional—<-1 : 1 - 231> with the minimum resolution of 2-31
The following list shows the accumulator types defined in the libraries:

+ Fixed-point 16-bit accumulator—<-256.0 ; 256.0 - 277> with the minimum resolution of 27

« Fixed-point 32-bit accumulator—<-65536.0 ; 65536.0 - 2-15> with the minimum resolution of 2-15
The following list shows the floating-point types defined in the libraries:

+ Floating point 32-bit single precision—<-3.40282 - 1038 ; 3.40282 - 103> with the minimum resolution of 2-23

1.1.3 API definition

GMCLIB uses the types mentioned in the previous section. To enable simple usage of the algorithms, their names use set prefixes
and postfixes to distinguish the functions' versions. See the following example:

f32Result = MLIB Mac_ F321ss (f32Accum, fl6Multl, fléMult2);

where the function is compiled from four parts:
* MLIB—this is the library prefix

* Mac—the function name—Multiply-Accumulate

* F32—the function output type
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» Iss—the types of the function inputs; if all the inputs have the same type as the output, the inputs are
not marked

The input and output types are described in the following table:

Table 1. Input/output types

Type Output Input
frac16_t F16 s
frac32_t F32 |
acc32_t A32 a

float_t FLT f

1.1.4 Supported compilers

GMCLIB for the ARM Cortex M33F core is written in C language or assembly language with C-callable interface depending on
the specific function. The library is built and tested using the following compilers:

* MCUXpresso IDE
* IAR Embedded Workbench
» Keil yVision
For the MCUXpresso IDE, the library is delivered in the gmclib.afile.
For the Kinetis Design Studio, the library is delivered in the gmclib.a file.
For the IAR Embedded Workbench, the library is delivered in the gmclib.afile.
For the Keil pVision, the library is delivered in the gmclib./ib file.

The interfaces to the algorithms included in this library are combined into a single public interface include file, gmclib.h. This is
done to lower the number of files required to be included in your application.

1.1.5 Library configuration

GMCLIB for the ARM Cortex M33F core is written in C language or assembly language with C-callable interface depending on the
specific function. Some functions from this library are inline type, which are compiled together with project using this library. The
optimization level for inline function is usually defined by the specific compiler setting. It can cause an issue especially when high
optimization level is set. Therefore the optimization level for all inline assembly written functions is defined by compiler pragmas
using macros. The configuration header file RTCESL_cfg.his located in: specific library folderlMLIBlInclude. The optimization
level can be changed by modifying the macro value for specific compiler. In case of any change the library functionality is

not guaranteed.

Similarly as optimization level the PowerQuad DSP Coprocessor and Accelerator support can be disable or enable if it has
not been done by defined symbol RTCESL_PQ_ON or RTCESL_PQ_OFF in project setting described in the PowerQuad DSP
Coprocessor and Accelerator support cheaper for specific compiler.

1.1.6 Special issues

1. The equations describing the algorithms are symbolic. If there is positive 1, the number is the closest number to 1 that
the resolution of the used fractional type allows. If there are maximum or minimum values mentioned, check the range
allowed by the type of the particular function version.

2. The library functions that round the result (the API contains Rnd) round to nearest (half up).

GMCLIB User's Guide, Rev. 5, 01 November 2021
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3. This RTCESL requires the DSP extension for some saturation functions. If the core does not support the DSP extension
feature the assembler code of the RTCESL will not be buildable. For example the core1 of the LPC55s69 has no DSP

extension.

1.2 Library integration into project (MCUXpresso IDE)

This section provides a step-by-step guide on how to quickly and easily include GMCLIB into any MCUXpresso SDK example or
new SDK project using MCUXpresso IDE. The SDK based project uses RTCESL from SDK package.

PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. This
section shows how to turn the PowerQuad (PQ) support for a function on and off.

1.

4.
5.

In the MCUXpresso SDK project name node or in the left-hand part, click Properties or select Project > Properties from the

menu. A project propert

ies dialog appears.

Expand the C/C++ Build node and select Settings. See Figure 1.

On the right-hand side, under the MCU C Compiler node, click the Preprocessor node. See Figure 1.

Run/Debug Settings (& Optimization
(% Debugging
(2 Wamings
(5 Miscellaneous
(2 Architecture
4 I MCU Assembler
(& General
(5 Architecture & Headers
4 B MCU Linker
(& General
(& Libraries
( Miscellaneous
(% Shared Library Settings
(2 Architecture
(2 Managed Linker Script
(& Multicore

- N
[ Properties for twrkv31f120m_demo_apps_hello_world (o o ]
type filter text Settings = - -

, Resource
Builders o
4 C/Cos Build Configuration: Debug [ Active ] ~| [Manage Configurations..
Build Variables
Environment
Logging & Tool Settings | & Build steps | " Build Artifact | [ Binary Parsers [ @ Error Parsers|
MCU settings
Settings 4 T MCU C Compiler [] Do not search system directories (-nostdine)
Toal Chain Editor (3 Dialect [T Preprocess only (-E}
» C/C++ General (B Preprocessor _
Defined symbols (-0} & a8 & E
Praject References 5 Includes ' 24888 H) |-

DEBUG
PRINTF_FLOAT_ENABLE=0
SCANF_FLOAT_ENABLE=0
PRINTF_ADVANCED_ENABLE=0
SCANF_ADVANCED_ENABLE=0
TWR_KV31F120M

TOWER
SDK_DEBUGCONSOLE=0

_ MCUXPRESSO

__USE_CMSIS
CPU_MKV3IFS12VLL12
CPU_MKV31FSL2VLL12_emd
_REDLIB_

Undefined symbals (-U) &

——

. b

Figure 1. Defined symbols

In the dialog that appears (see Figure 2), type the following:

* RTCESL_PQ_ON—to turn the PowerQuad support on

* RTCESL_PQ_OFF—to turn the PowerQuad support off

GMCLIB User's Guide, Rev. 5, 01 November 2021
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If neither of these two defines is defined, the hardware division and square root support is turned off by default.
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Defined symbols (-D)

RTCESL PQ_ON

[ ok ][ Cconcel ]

Figure 2. Symbol definition

6. Click OK in the dialog.
7. Click OK in the main dialog.

Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_Init(); prior to the first function using PQ
module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and
Accelerator support.

Adding RTCESL component to project

The MCUXpresso SDK package is necessary to add any example or new project and RTCESL component. In case the

package has not been downloaded go to mcuxpresso.nxp.com, build the final MCUXpresso SDK package for required board and
download it.

After package is dowloaded, open the MCUXpresso IDE and drag&drop the SDK package in zip format to the Installed SDK

window of the MCUXpresso IDE. After SDK package is dropped the mesage accepting window appears as can be show in
following figure.

B MCUX workspace - MCUXpresso IDE - o x
File Edit MNavigate Search Project Configlools Run RIOS Analysis Window Help
i 2 | &~ &~ L2 TR R R AT RS = N T O I Y
U NP A FRURE R AT REERORAN . | Q im|lK
[ Project Ex... 51 4 Registers %% Fauls &, Periphera.. = O =g

BlEvY 8% B3

There are no projects in your warkspace.

To add a project:

B8 Creote o new MCUXpresso IDE C/C++ project.

B8 Import examples from SDK. X MCUXpresso IDE SDK import u} X

% Create 3 project...

i Import projects.. Py

@) Areyou sureyou want to import the following SDK in the
&Y' commen ‘meuxpresso’ folder?

D:ASDK_2_10_0_HVP-KV31F120Mzzip
@ inst.. 2 [ Prop.. [2 Py ]
(=]
@ Installed SDKs
() Quickstart Panel 52 (x)=Variables ®g Breakpoints = O Teinstallan SDK, simply drag and lpres:
X A [Installed SDKs . Availeble Board
MCUXpresso IDE - Quickstart Panel N
1 ] No project selected ame
~ Create or import a project
J— B New project...
B import SDK excemelets).. []Do not sk for confirmation on SDK Drag and Drop install
® Import project(s) from file system...
B’
v LR 4 >
o { ) MCUX workspace L

Figure 3. MCUXpresso IDE - imporing the SDK package to MCUXpresso IDE
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Click OK to confirm the SDK package import. Find the Quickstart panel in left bottom part of the MCUXpresso IDE and click New
project... item or Import SDK example(s)... to add rtcesl component to the project.

Library

8 MCUX workspace - MCU¥presso IDE

File Edit Mavigate

H[mif &2

Search Project Configlools Run RTOS Analysis Window Help

l®-&-i¢vie -4 -0 -Q-i® /- EE1iDiu|o
Si@e i Ni-F-ow a0
[¥5 Project Ex... 2 !} Registers % Faults [, Periphera.. = O

SRR R
There are no projects in your workspace.
To add a project:

B8 Create a new MCUXpresso IDE C/C++ project.

B Import examples from SDK.

9 Create a project..

i Import projects...

@ inst. 52 [OProp.. [2 Probl.. B Cons.. @

() Installed SDKs
(1) Quickstart Panel 57 (%)= Variables ©g Breakpoints = To install an SDK, simply drag and drop an SOK (zip file/fo

- a x
B n SR k0 ED R
Q K

= 8

Term... [gj Ima.. G}Debu. 2 Offfin. = B
®o D

Ider) into the ‘Installed SDKs' view. [Common 'mcuxpres

~
MCUXpresso IDE - Quickstart Panel
No project selected

\DE

Installed SDKs “. Available Boards| Available Devices |
Name

SDK Versien

HHHSDK 2. HVP-KV31F120M 2100
~ Create or import a project

Manifest Version  Location

380 &

Invoke the new SDK project wizard

~ Build your project

@

\SDK_2_10_0_HVP-KY

() MCUX workspace

Figure 4. MCUXpresso IDE - create new project or Import SDK example(s)

Then select your board, and clik Next button.

3 50K Wizard

(@) Creating project for device: MKV31F512ccx 12 using board: HVP-KV31F120M

. Board and/or Device selection page

~ SDK MCUs . Available boards

MCUs from installed SDKs. Please click

above or visit mcuxpresso.mxp.com to

Please select an available board for your project.
obtain additional SDKs.

[ Supported boards for device: MKV3TFS120012

NP MKV3TF512300x12

v KV3x
MKV3TF512xxx12

hvpkv31£120m

~ Preinstalled MCUs
MCUs from preinstalled LPC and
generic Cortex-M part support
NXP PN7462AU-C3-00 "
PN7462AU-C2-00
PN7462AU-C3-00
Generic-MD
Generic-Moplus
Generic-M23
Generic-M3
Generic-M33
Generic-M4
Generie-M7

v

Selected Device: MKV31F512300¢12 using board: HVP-KV31F120M
Target Core: emd
Description:

SDKs for selected MCU

Name
Kinetis KV3x-100-120 MHz, Advanced 3ph FOC / Sensorless Motor Control MCUs

SDK Version  Mani
based on ARM Cortex-M4

5 SDK_2x_HVP-KV3TF120M 2,100 (494 20 3.8.0

@

ifest Ve... Location

JE <Common>\SDK_2_10_0_HVP-KV:

<Back

Finish Cancel

Figure 5. MCUXpresso IDE - selecting the board
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Find the Middleware tab in the Components part of the window and click on the checkbox to be the rtcesl component ticked. Last
step is to click the Finish button and wait for project creating with all RTCESL libraries and include paths.

3 soK Wizard u] X
i, The source from the SDK will be copied into the workspace. If you want to use linked files, please unzip the 'SDK_2x_HVP-KV31F120M' SDK. VA &
. Configure the project
Project neme: | MKV31F31212_FirstProject] * | Project name suffix:

Use default location

C:\MCUX_workspace\MKV31F51212_FirstProject Browse.
Device Packages Board Project Type Project Options
MKVZIF512VLL12 Defautt board files SDK Debug Console (O Semihost (@ UART
@ CProject O C++ Project ]
O MKVZTFS12VLHT2 O Empty board files [ cMsis-Core

(O Cstatic Library () C++ Static Library Copy sources

[ Import other files

Components [F] Components selection summary B
Add or remove SDK software components

[typetofitter |

Operating Systems Drivers [ CMSIS Drivers  Utilities [Middleware . Board Components| Abstraction Layer | Software C:

Name Description  Ver.. Info
Middleware B%| BB = Drivers

Middleware

Operating Systems

Software Component

Utilities

[typetofitter |

Neme Description Version Info
[ E FreeMASTER

000 60D 000 000 D

n otor Control
Real Time Control Embedded Software Library for CM... 1.1.0 Real Time Control Embedded Software Library for CM4F core

3
@

<Back Next> T

Figure 6. MCUXpresso IDE - selecting rtcesl component

Type the #include syntax into the code where you want to call the library functions. In the left-hand dialog, open the required .c
file. After the file opens, include the following lines into the #include section:

#include "mlib FP.h"
#include "gflib FP.h"
#include "gmclib FP.h"

When you click the Build icon (hammer), the project is compiled without errors.

1.3 Library integration into project (Keil pVision)

This section provides a step-by-step guide on how to quickly and easily include GMCLIB into an empty project or any
MCUXpresso SDK example or demo application projects using Keil pVision. This example uses the default installation path
(C:ANXP\RTCESL\CM33F_RTCESL_4.7_KEIL). If you have a different installation path, use that path instead. If any MCUXpresso
SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read
next chapter.

NXP pack installation for new project (without MCUXpresso SDK)

This example uses the NXP LPC55s69 part, and the default installation path (C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL) is
supposed. If the compiler has never been used to create any NXP MCU-based projects before, check whether the NXP MCU pack
for the particular device is installed. Follow these steps:

1. Launch Keil pyVision.

2. In the main menu, go to Project > Manage > Pack Installer....

3. In the left-hand dialog (under the Devices tab), expand the All Devices > Freescale (NXP) node.
4

. Look for a line called "KVxx Series" and click it.

GMCLIB User's Guide, Rev. 5, 01 November 2021
User Guide 10/98




NXP Semiconductors

In the right-hand dialog (under the Packs tab), expand the Device Specific node.

When installed, the button has the "Up to date" title. Now close the Pack Installer.

Library

Look for a node called "Keil::Kinetis_KVxx_DFP." If there are the Install or Update options, click the button to install/
update the package. See Figure 7.

{6 Pack Installer - Ci\Keil uS\ARM\PACK - ==& = ]
File Packs Window Help
> ‘ Device: Freescale - Kvox Series
4 Devices | Boards | | |la] " Packs | Examples | |
‘ Search: - X Pack Description
Iff 2evice /| summary 171 Device Specific
@ Atmel 257 Devices ||| KeaKinetis Ko DFP Freescale Kinetis Ko Series Device Support
@ Freescale 234 Devices El-Generic
% K Series 1 Device ARMECMSIS CMSIS (Cortex Microcontraller Software Interface Standard)
%2 K00 Series. 2 Devices Keil:zARM_Compiler Keil ARM Compiler extensions
%2 K10 Series. 23 Devices Keil:lansson Jansson is a C library for encoding, decoding and manipula
42 K20 Series. #1 Devices Keil:zMDK-Middleware Keil MDK-ARM Professional Middleware for ARM Cartex-M
%2 K30 Series. 6 Devices Keil:zMDK-Network_D! Keil MDK-ARM Professional Middleware Dual-Stack IPv4/IP
% K40 Series. 6 Devices WPz wIP IWIP is 2 light-weight implementation of the TCP/IP protoc
%2 K50 Series. 11 Devices Micrium:RTOS Micrium software components
%2 K60 Series. 18 Devices Ory Package (CycloneTCP, CycloneSSL and Cyclon
%2 K70 Series. 3 Devices WoIfSSL:CyaSSL Light weight SSL/TLS and Crypt Library for Embedded Syste
%2 K80 Series. 2 Devices 1 YOGITECH:fRSTL_AR... |& YOGITECH fRSTL Functional Safety EVAL Software Pack for
. KEAvo Series 6 Devices
Kb Series 11 Devices
Kl Series 54 Devices
A Koo Series 14 Devices
A Kiioc Series 26 Devices
. Koo Series 8 Devices
% WPRISI6 Series |1 Device
&t i )l i
Output 3 x
Refresh Pack descriptions
Update available for Keil:MDK-Middleware (installed: 6.4.0, available: 7.0.0-beta)
Ready [ [onume

Figure 7. Pack Installer

New project (without MCUXpresso SDK)

To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Follow
these steps to create a new project:

1.
2.

N o o &

Launch Keil pVision.

In the main menu, select Project > New pVision Project..., and the Create New Project dialog appears.

Navigate to the folder where you want to create the project, for example C:\KeilProjects\MyProject01. Type the name of the
project, for example MyProject01. Click Save. See Figure 8.

Create New Project

* Browse Folders

Figure 8. Create New Project dialog

File name:  MyProject0l

Save as type: |Project Files (“uvproj: ".uvprojs)

Expand the node.
Click the LPC55s69 node, and then click OK. See Figure 9.
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-
Device |Targe¢| Ol.rlputl Listing I User | C/CH-I Asm I Linkerl Debug I Uhl'rtiesl I
ISoﬂware Packs ;I
Vendor: NXP Software Pack
Device: LPC55563JBD100:cm33 cored Pack: [NXP.LPC35569_DFP.12.11
Toolset: ARM URL:  http://mcuxpresso nxp com/cmsis_pack/frepe
Search:
¥ ARM 4 || |The LPCESx/LPC555xx is an ARM Cortex M33 based micro-
@ NP controller for embedded applications. These devices include up to
El 320 KB of on-chip SRAM, up to 640 KB on-chip flash, high-speed
2 K32L2A41A and full-speed USB host and device interface with crystaldess
\)[g . operation for full-speed, five general-purpose timers, one
KExx Series SCTimer/PWM, one RTC/alam timer, one 24-bit Mutti-Rate Timer
2% LPC55560 (MRT), a Windowed Watchdog Timer (WWDT), eight flexible senal
communication peripherals {each of which can be a USART, SPI,
=] ‘%3 LPC55569 12C. or 125 interface), one 16-bit 1.0 Msamples/eec ADC, temperature
B4 LPC555691BD100 sensor.
&3 LPC55569/BD100
€3 LPC53569/BD100
4 I b I r T
QK I Cancel Help
Figure 9. Select Device dialog

8. In the next dialog, expand the Device node, and tick the box next to the Startup node. See Figure 10.

9. Expand the CMSIS node, and tick the box next to the CORE node.

Figure 10. Manage Run-Time Environment dialog

10. Click OK, and a new project is created. The new project is now visible in the left-hand part of Keil yVision. See Figure 11.

ChKeilProj %) __'_El:l:ﬂl My Projectl. Jx - ‘lul"_'
E! \KeilProjects\MyProj MWy Praoj uvprojx - pVisicn I

File Edit WView Project Flash Debug Peripherals Tool

NE @ & i | Bal:
LR B o2 L ££|Target1 Eﬁ&|

Project n 3
=55 device j
| L] fsl_device_registers.h

L] LPC55569_cm33_corel.h

L] LPC55569_cm33_corel_features.h

L] system_LPC55569_cm33_corel.c

L] system_LPC55568_cm33_corellh
=L startup

] startup_LPC55569_cm33_corel.S

Figure 11. Project

11. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.
12. Select the Target tab.

13. Select Use Single Precision in the Floating Point Hardware option. See Figure 11.
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—Code Generation

[~ Use Cross-Module Optimization

ARM Compiler: ILlse default compiler version

[ Use MicroLIB [T BigEndian

Floating Point Hardware: Usze Single Precision [

=

Figure 12. FPU

PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. This

section shows how to turn the PowerQuad (PQ) support for a function on and off.

1. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.

2. Select the C/C++ tab. See Figure 13.

3. In the Include Preprocessor Symbols text box, type the following:

+ RTCESL_PQ_ON—to turn the hardware division and square root support on.

* RTCESL_PQ_OFF—to turn the hardware division and square root support off.

If neither of these two defines is defined, the hardware division and square root support is turned off by default.

B

|

De\ricel Tanget | Outputl Listingl User C/Cs++ |km I Linkerl Debug | Lkilties |

— Prep Symbaols

Define: IF{TCESL_F'Q_ON

Undefine: I

 Language / Code Generation

™ Execute-only Code [~ Strict ANSIC

Optimization: lm I Enum Container always int

I~ Optimize for Time [~ Plain Charis Signed

I~ Split Load and Store Muliple ™ Read-Only Position Independent
I~ One ELF Section per Function [~ Bead-Write Postion Independert

Wamings

All Wamings -
T Thumb Mode

™ No Auto Includes
[~ C99 Mode

Include I
Paths

Misc I
Cortrols

Compiler |- —cpu Cortex-M4fp -D__EVAL -g 00 —apcs=interwork
control |- C:\KeilProjects \MyProject01W\RTE
string

Defaults

Figure 13. Preprocessor symbols

4. Click OK in the main dialog.

5. Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_Init(); prior to the first function using PQ

module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and

Accelerator support.
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Linking the files into the project

GMCLIB requires MLIB and GFLIB to be included too. The following steps show how to include all dependent modules.

To include the library files in the project, create groups and add them.

Library

1. Right-click the Target 1 node in the left-hand part of the Project tree, and select Add Group... from the menu. A new group

with the name New Group is added.

2. Click the newly created group, and press F2 to rename it to RTCESL.

3. Right-click the RTCESL node, and select Add Existing Files to Group 'RTCESL'... from the menu.

4. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\MLIB\Include, and select the

miib_FP.hfile. If the file does not appear, set the Files of type filter to Text file. Click Add. See Figure 14.

Look in: | | Include

Mame

[ MLIB_Div1Q_F32

[ mlib_FP

[ MLIB_Log2_U16

[2f MLIB_Mac_A32

[ MLIB_Mac_F16_Asmi
[ MLIB_Mac_F32

[&f MLIB_Mac_F32_Asmi
[ MLIB_Mac_FLT

[2f MLIB_Mac4_F32

[ MLIB_Macd_F32_Asmi

[ am1o Rt T T

i | mn

~| & & cf B

Date modified i

6,/20/2016 9:49 AM
7/22/20161:15 PM

6,/20/2016 9:49 AM K

6/20/2016 9:49 AM
7/25/2016 8:27 AM
6,/20/2016 9:49 AM
7/25/2016 8:27 AM
6,/20/2016 9:49 AM
6/20/2016 9:49 AM
7/25/2016 8:27 AM

AN E OLAn ARA
k

File name: |n1|ib_FF‘

Files of type: |Taxt file (“td:; *h; “inc)

Figure 14. Adding .h files dialog

j Close

5. Navigate to the parent folder C:ANXP\RTCESL\CM33F_RTCESL_4.7_KEIL\MLIB, and select the mlib./ibfile. If the file does
not appear, set the Files of type filter to Library file. Click Add. See Figure 15.
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Look in: |}, MLIB ~| & & et E-

MName . Date modified Ty
! Include 2010.2014 15:37 Fi

|| MLIB.lib 16.10.2014 9:19 L

1| m

| F
File name: |I".-'ILIB.Iib
Files of type: | Library file (" i) =l Close

Figure 15. Adding .lib files dialog

6. Navigate into the library installation folder C:\ANXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GFLIB\Include, and select the
gflib_FP.hfile. If the file does not appear, set the Files of type filter to Text file. Click Add.

7. Navigate to the parent folder C:ANXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GFLIB, and select the gflib./ibfile. If the file
does not appear, set the Files of type filter to Library file. Click Add.

8. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GMCLIB\Include, and select the
gmclib_FP.hfile. If the file does not appear, set the Files of type filter to Text file. Click Add.

9. Navigate to the parent folder C:\ANXP\ARTCESL\CM33F_RTCESL_4.7_KEIL\GMCLIB, and select the gmclib./ibfile. If the file
does not appear, set the Files of type filter to Library file. Click Add.

10. Now, all necessary files are in the project tree; see Figure 16. Click Close.
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| Project 1 B
2% Project: MyProjectll
gy Targetl
L1 Source Group 1
= RTCESL
mlib_FP.h
MLIB.lib
gflib_FP.h
GFLIB.lib
gmclib_FP.h
GMCLIE.lib
& CMss
= 9 Device

(T R Y R Y

Figure 16. Project workspace

Library path setup

The following steps show the inclusion of all dependent modules.
1. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.
2. Select the C/C++ tab. See Figure 17.

3. Inthe Include Paths text box, type the following paths (if there are more paths, they must be separated by ';') or add them
by clicking the ... button next to the text box:

+ "C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\MLIB\Include"
+ "C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GFLIB\Include"
+ "C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GMCLIB\Include"
4. Click OK.
5. Click OK in the main dialog.
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k] Options for Target ‘Target 1

Devicel Target | Oulpull Listingl User C/Ce+ |.&'sm I Linkerl Debug | Ltilities |

Symbals

Define: I
Undefine: I

— Language / Code Generation

I~ Stict ANSIC e
Optimization: lm I™ Enum Container abways int All'Wamings j'
I Optimize for Time ™ Plain Char is Signed = Thurmb Mode
I~ Split Load and Store Muttiple [~ Read-Cnly Position Independent [~ No Auto Includes
[~ One ELF Section per Function [~ Read-Write Postion Independert [~ C39 Mode

Include ||
Paths

Misc I
Controls

Compiler  |-¢ —cpu Cortex-M0+ -D__EVAL -g -00 —apcs=interwork
control [ C:\KeilProjects \MyProject01\RTE
string

Figure 17. Library path addition

Type the #include syntax into the code. Include the library into a source file. In the new project, it is necessary to create a
source file:

1. Right-click the Source Group 1 node, and Add New Item to Group 'Source Group 1'... from the menu.

2. Select the C File (.c) option, and type a name of the file into the Name box, for example 'main.c. See Figure 18.

: e e o o ompe
v o s or T

Create a new C source file and add it to the projec
C | CFile{c)

@ C++ File {.cpp)
\ﬂ Asm File ()

@ Header File (h)
é Text File (bd)
Qg\ Image File (%
1@ User Code Template

Type: I

Mame: I main.

Location: I C:\KeilProjects\MyProjectd1

Figure 18. Adding new source file dialog

3. Click Add, and a new source file is created and opened up.
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4. In the opened source file, include the following lines into the #include section, and create a main function:

#include "mlib FP.h"
#include "gflib FP.h"
#include "gmclib FP.h"

int main (void)
{

while (1) ;
}

When you click the Build (F7) icon, the project will be compiled without errors.

1.4 Library integration into project (IAR Embedded Workbench)

This section provides a step-by-step guide on how to quickly and easily include the GMCLIB into an empty project or any
MCUXpresso SDK example or demo application projects using IAR Embedded Workbench. This example uses the default
installation path (C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR). If you have a different installation path, use that path instead. If
any MCUXpresso SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter
otherwise read next chapter.

New project (without MCUXpresso SDK)

This example uses the NXP LPC55S69 part, and the default installation path (C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR) is
supposed. To start working on an application, create a new project. If the project already exists and is opened, skip to the next
section. Perform these steps to create a new project:

1. Launch IAR Embedded Workbench.

2. In the main menu, select Project > Create New Project... so that the "Create New Project" dialog appears. See Figure 19.

-~ =

Toal chair: | AFiM ~|

Froject templates:
- A3 -
[ C++

- ‘: ‘

| r
DLIB [C. C++ with exception: and RTTI]
DLIB [C, Extended Embedded C++) i

Description:

C project uzing default tool settings inchuding an emply main.c file.

Figure 19. Create New Project dialog

3. Expand the C node in the tree, and select the "main" node. Click OK.

4. Navigate to the folder where you want to create the project, for example, C:\IARProjects\MyProject01. Type the name of the
project, for example, MyProject01. Click Save, and a new project is created. The new project is now visible in the left-hand
part of IAR Embedded Workbench. See Figure 20.
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& 1AR Embedded Workbench IDE
.

File Edit View Project Simulator Tools Window Help

Ded@ & 2R o - 4
Workspace * | main.c |

[Debug v]
|| Files 2 O e

=f&]MyProjectdl -Deb... [« | | return 0

main.c o |

L@ 3 Output

Figure 20. New project

5. In the main menu, go to Project > Options..., and a dialog appears.

6. Inthe Target tab, select the Device option, and click the button next to the dialog to select the MCU. In this example, select
NXP > LPC55S69 > NXP LPC55S69_core0. Select VFPV5 single precision in the FPU option.The DSP instructions group
is required please check the DSP Extensions checkbox if not checked. Click OK. See Figure 21.

:

Category:
Static Analysis Library Options 2 MISRA-C:2004 MISRA-C:1398
Rg?chfi E::n:lr;? Target Qutput Library Configuration Library Options 1
Assembler Processor variant
Qutput Converter O Core Cortex-M33
Custom Build
Build Actions (® Device NXP LPC55569_coreD B
Linker
Debugger OCMsISPack  MMore
Simulator
Angel Endian mode Floating point settings
CMSIS DAP Litle - —
GDE Server b FPU VFPv5 single precision
I'ﬂfR ROM-r!'lonihor E12 D reqisters 16 i
I4jet/ITAGjet =
Jink/1-Trace BE2
TI Stellaris TrustZone
Macraigor DSP Extension
) Mod ~
PE micra Advanced SIMD (NEON) ode [Non-secure
RDI
STALINK
Third-Party Driver
TLXDS (0] 3 ] [ Cancel

Figure 21. Options dialog

PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. Only
functions runing faster through the PowerQuad module than the core itself are supported and targeted to be calculated by the
PowerQuad module. This section shows how to turn the PowerQuad (PQ) support for a function on and off.

1. In the main menu, go to Project > Options..., and a dialog appears.
2. In the left-hand column, select C/C++ Compiler.

3. Inthe right-hand part of the dialog, click the Preprocessor tab (it can be hidden in the right-hand side; use the arrow icons
for navigation).
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4. In the text box (at the Defined symbols: (one per line)), type the following (See Figure 22):
+ RTCESL_PQ_ON—to turn the PowerQuad support on.
+ RTCESL_PQ_OFF—to turn the PowerQuad support off.

If neither of these two defines is defined, the hardware division and square root support is turned off by default.

Options for node "MyProject01” | P |

Categony: Factory Settings

General Options [ Multifile Compilation

Static Analysis Discard Unused Publics
Runtime Chedking

[ Language 2 | Code | Optimizations | Output | List | Preprocessor [[« ]

Assembler
Output Converter [ lgnore standard include directories

Custom Build Additional include directories: jone per ling)
Build Actions " E]

Linker
Debuager
Simulator
Angel
CMSIS DAP Preinclude file:
GDE Server E]
TAR. ROM-monitor
T4et/TTAGIet Defined symbols: (one per line)
1ink{1-Trace RTCESL_FQ_ON A || Preprocessor outpit to file
TI Stellaris Preserve comments
Macraigor 1 Generate Hine directives

PE micro

RDI

ST-LIMK
Third-Party Driver
TI XDS

QK. ] l Cancel

L. A

Figure 22. Defined symbols

5. Click OK in the main dialog.

6. Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_lInit(); prior to the first function using PQ
module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and
Accelerator support.

Library path variable
To make the library integration easier, create a variable that will hold the information about the library path.
1. In the main menu, go to Tools > Configure Custom Argument Variables..., and a dialog appears.

2. Click the New Group button, and another dialog appears. In this dialog, type the name of the group PATH, and click OK.
See Figure 23.
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.
i ' Configure Custom Argument Variables |i|
Workspace | Global
Enable Group
| |“Eoup. -
MNew Group i »
Fiable...
M : E
ame PATH Ebie....
lete
oK l [ Cancel -
prt...
Expand/Collapse All
[ Hide disabled groups
oK l l Cancel
- e - ’.

Figure 23. New Group

Click on the newly created group, and click the Add Variable button. A dialog appears.
Type this name: RTCESL_LOC

To set up the value, look for the library by clicking the '..." button, or just type the installation path into the box:
C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR. Click OK.

In the main dialog, click OK. See Figure 24.

# ' Configure Custom Argument Variables [ = |
Workspace | Global
[ pATH Disable Group
,
Add Variable ==
Name: |RTCESL_LOC |
Value: |C:\NXP\,RTCESL_CM33F_RTCESL_X.X_IAR | 0O |[ B
[ OK. J[ Cancel ]
2|

Figure 24. New variable

Linking the files into the project

GMCLIB requires MLIB and GFLIB to be included too. The following steps show the inclusion of all dependent modules.

To include the library files into the project, create groups and add them.

1.

Go to the main menu Project > Add Group...

2. Type RTCESL, and click OK.

3. Click on the newly created node RTCESL, go to Project > Add Group..., and create a MLIB subgroup.

4.

5. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\MLIB\Include, and select the m/ib.h

Click on the newly created node MLIB, and go to the main menu Project > Add Files... See Figure 26.

file. (If the file does not appear, set the file-type filter to Source Files.) Click Open. See Figure 25.
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6.

7.
8.
9.

Library
Navigate into the library installation folder C:ANXP\ARTCESL\CM33F_RTCESL_4.7_IAR\MLIB, and select the miib.afile. If
the file does not appear, set the file-type filter to Library / Object files. Click Open.
T |
b System (C:) » NXP » RTCESL » CM33 RTCESLX.XIAR » MLE » Include

i MName . Date modified Type

. mlib.h 16.10.2015 9:38 H File

. MLUB_Abs_F16.h 16.10.2015 9:38 H File

Figure 25. Add Files dialog

Click on the RTCESL node, go to Project > Add Group..., and create a GFLIB subgroup.
Click on the newly created node GFLIB, and go to the main menu Project > Add Files....

Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\GFLIB\Include, and select the
gflib.hfile. (If the file does not appear, set the file-type filter to Source Files.) Click Open.

10. Navigate into the library installation folder C:ANXP\ARTCESL\CM33F_RTCESL_4.7_IAR\GFLIB, and select the gfiib.afile.

If the file does not appear, set the file-type filter to Library / Object files. Click Open.

11. Click on the RTCESL node, go to Project > Add Group..., and create a GMCLIB subgroup.
12. Click on the newly created node GMCLIB, and go to the main menu Project > Add Files....
13. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\GMCLIB\Include, and select the
gmclib.hfile. If the file does not appear, set the file-type filter to Source Files. Click Open.
14. Navigate into the library installation folder C:ANXP\RTCESL\CM33F_RTCESL_4.7_IAR\GMCLIB, and select the gmclib.a
file. If the file does not appear, set the file-type filter to Library / Object files. Click Open.
15. Now you will see the files added in the workspace. See Figure 26.
Workspace x
[Debug -
Files S H
B (F MyProjectd1 - Debug * v
- CIRTCESL
FaCOGFLB
| —[OIGFLB=
| Y k) oflin_FF.h
o L EEE
| — [OGMCLB.A
| Y [ gmclib_FPh
La CIMLIE
— CIMLEB.&
— |kl mlib_FF.h
main.c .
[ Cutpout
Figure 26. Project workspace
Library path setup
The following steps show the inclusion of all dependent modules:
1. In the main menu, go to Project > Options..., and a dialog appears.
2. In the left-hand column, select C/C++ Compiler.
3.

In the right-hand part of the dialog, click on the Preprocessor tab (it can be hidden in the right; use the arrow icons
for navigation).
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4. In the text box (at the Additional include directories title), type the following folder (using the created variable):
+ $RTCESL_LOCS$\MLIB\Include
« $RTCESL_LOCS$\GFLIB\Include
+ $RTCESL_LOCS$\GMCLIB\Include

5. Click OK in the main dialog. See Figure 27.

F ™
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Angel SRTCESL_LOCS'\GMCLIBNnclude|

CMSIS DAP
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IAR ROM-manitor Preinclude file:

IHet/TTAGjet - E]
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TLXDS

[ 0K ] [ Cancel

Figure 27. Library path adition

Type the #include syntax into the code. Include the library included into the main.cfile. In the workspace tree, double-click the
main.cfile. After the main.c file opens up, include the following lines into the #include section:

#include "mlib FP.h"

#include "gflib FP.h"
#include "gmclib FP.h"

When you click the Make icon, the project will be compiled without errors.

GMCLIB User's Guide, Rev. 5, 01 November 2021
User Guide 23/98




NXP Semiconductors

Chapter 2

Algorithms in detall

2.1 GMCLIB_Clark

The GMCLIB_Clark function calculates the Clarke transformation, which is used to transform values (flux, voltage, current) from
the three-phase coordinate system to the two-phase (a-B) orthogonal coordinate system, according to the following equations:

R

2.1.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.

» Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GMCLIB_Clark function are shown in the following table:

Table 2. Function versions

Function name

Input type

Output type

Result type

GMCLIB_Clark_F16

GMCLIB_3COOR_T_F16 *

GMCLIB_2COOR_ALBE_T_F16 *

void

Clarke transformation of a 16-bit fractional

system. The input and output are within the fractional range <-1 ; 1).

three-phase system input to a 16-bit fractional two-phase

GMCLIB_Clark_FLT

GMCLIB_3COOR_T_FLT *

GMCLIB_2COOR_ALBE_T_FLT *

void

Clarke transformation of a 32-bit single precision floating-point three-phase system input to a
32-bit single-point floating-point two-phase system. The input and output are within the full 32-bit

single-point floating-point range.

2.1.2 Declaration

The available GMCLIB_Clark functions have the following declarations:

void GMCLIB Clark F16(const GMCLIB 3COOR T F16 *psIn, GMCLIB 2COOR ALBE T F16 *psoOut)
void GMCLIB Clark FLT (const GMCLIB 3COOR T FLT *psIn, GMCLIB 2COOR ALBE T FLT *psOut)

2.1.3 Function use

The use of the GMCLIB_Clark function is shown in the following examples:

Fixed-point version:

#include "gmclib.h"

static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;
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void Isr (void) ;

void main (void)
{
/* ABC structure initialization */
sAbc.fl16A = FRAC16(0.0);
sAbc.fl16B = FRAC16(0.0);
sAbc.fl6C = FRAC16(0.0);

/* Periodical function or interrupt */
void Isr(void)
{
/* Clarke Transformation calculation */
GMCLIB Clark F16(&sAbc, &sAlphaBeta);

Algorithms in detail

Floating-point version:
#include "gmclib.h"

static GMCLIB_2COOR ALBE T FLT sAlphaBeta;
static GMCLIB_3COOR_T_FLT sAbc;

void Isr (void) ;

void main (void)
{
/* ABC structure initialization */
sAbc.fltA = 0.0F;
sAbc.fltB = 0.0F;
sAbc.fltC = 0.0F;

/* Periodical function or interrupt */
void Isr (void)
{
/* Clarke Transformation calculation */
GMCLIB Clark FLT (&sAbc, &sAlphaBeta);

2.2 GMCLIB_Clarkinv

The GMCLIB_ClarkInv function calculates the Clarke transformation, which is used to transform values (flux, voltage, current) from
the two-phase (a-8) orthogonal coordinate system to the three-phase coordinate system, according to the following equations:
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2.2.1 Available versions

This function is available in the following versions:

Algorithms in detail

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.
» Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GMCLIB_Clarkinv function are shown in the following table:

Table 3. Function versions

Function name Input type Output type

Result type

GMCLIB_Clarklnv_F16 GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_3COOR_T_F16 *

void

three-phase output. The input and output are within the fractional range <-1 ; 1).

Inverse Clarke transformation with a 16-bit fractional two-phase system input and a 16-bit fractional

GMCLIB_Clarkinv_FLT GMCLIB_2COOR_ALBE_T_FLT * GMCLIB_3COOR_T_FLT *

void

full 32-bit single-point floating-point range.

Inverse Clarke transformation with a 32-bit single precision floating-point two-phase system input
and a 32-bit single precision floating-point three-phase output. The input and output are within the

2.2.2 Declaration
The available GMCLIB_Clarkinv functions have the following declarations:
void GMCLIB ClarkInv F16(const GMCLIB 2COOR ALBE T F16 *psIn, GMCLIB 3COOR T F16 *psOut)

void GMCLIB ClarkInv FLT (const GMCLIB 2COOR ALBE T FLT *psIn, GMCLIB 3COOR T FLT *psOut)

2.2.3 Function use

The use of the GMCLIB_ClarkInv function is shown in the following examples:

Fixed-point version:
#include "gmclib.h"

static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB 3COOR T F16 sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

}

/* Periodical function or interrupt */

void Isr (void)

{
/* Inverse Clarke Transformation calculation */
GMCLIB ClarkInv_F16 (&sAlphaBeta, &sAbc);

}
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Floating-point version:
#include "gmclib.h"

static GMCLIB 2COOR ALBE T FLT sAlphaBeta;
static GMCLIB 3COOR T FLT sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fltAlpha = 0.0F;
sAlphaBeta.fltBeta = 0.0F;

}

/* Periodical function or interrupt */

void Isr (void)

{
/* Inverse Clarke Transformation calculation */
GMCLIB ClarkInv_FLT (&sAlphaBeta, &sAbc);

}

2.3 GMCLIB_Park

The GMCLIB_Park function calculates the Park transformation, which transforms values (flux, voltage, current) from the stationary
two-phase (a-B) orthogonal coordinate system to the rotating two-phase (d-q) orthogonal coordinate system, according to the
following equations:

d = a-cos(6)+ B-sin(6)

q= ﬁ-cos(@) -o sin(@)

where:

» B is the position (angle)

2.3.1 Available versions
This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

* Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GMCLIB_Park function are shown in the following table:

Table 4. Function versions

Function name Input type Output type Result type

GMCLIB_Park_F16 GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_2COOR_DQ_T_F16 * void

GMCLIB_2COOR_SINCOS_T_F16 *

Table continues on the next page...
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Function name Input type Output type

Result type

information. The inputs and the output are within the fractional range <-1; 1).

The Park transformation of a 16-bit fractional two-phase stationary system input to a 16-bit fractional
two-phase rotating system, using a 16-bit fractional angle two-component (sin / cos) position

GMCLIB_Park_FLT GMCLIB_2COOR_ALBE_T_FLT * GMCLIB_2COOR_DQ_T_FLT *

GMCLIB_2COOR_SINCOS_T_FLT *

void

the range <-1.0; 1.0>.

The Park transformation of a 32-bit single precision floating-point two-phase stationary system input
to a 32-bit single precision floating-point two-phase rotating system, using a 32-bit single precision

floating-point angle two-component (sin / cos) position information. The two-phase stationary system
input and the output are within the full 32-bit single-point floating-point range; the angle input is within

2.3.2 Declaration

The available GMCLIB_Park functions have the following declarations:
void GMCLIB Park F16(const GMCLIB 2COOR ALBE T F16 *psIn, const GMCLIB 2COOR SINCOS T F16
*psAnglePos, GMCLIB 2COOR DQ T F16 *psOut)

void GMCLIB Park FLT(const GMCLIB 2COOR ALBE T FLT *psIn, const GMCLIB 2COOR_SINCOS T FLT
*psAnglePos, GMCLIB 2COOR DQ T FLT *psOut)

2.3.3 Function use

The use of the GMCLIB_Park function is shown in the following examples:

Fixed-point version:
#include "gmclib.h"

static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB_2COOR DQ T_F16 sDQ;
static GMCLIB_2COOR_SINCOS_T_F16 sAngle;

void Isr (void);

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

/* Angle structure initialization */
sAngle.f16Sin = FRAC16(0.0);
sAngle.f16Cos = FRAC16(1.0);

/* Periodical function or interrupt */
void Isr (void)
{

/* Park Transformation calculation */
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GMCLIB Park F16(&sAlphaBeta, &sAngle, &sDQ);
}

Floating-point version:
#include "gmclib.h"

static GMCLIB 2COOR ALBE T FLT sAlphaBeta;
static GMCLIB 2COOR DQ T FLT sDQ;
static GMCLIB 2COOR SINCOS T FLT sAngle;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fltAlpha = 0.0F;
sAlphaBeta.fltBeta = 0.0F;

/* Angle structure initialization */
sAngle.fltSin = 0.0F;
sAngle.fltCos = 1.0F;

/* Periodical function or interrupt */
void Isr(void)
{
/* Park Transformation calculation */
GMCLIB Park FLT (&sAlphaBeta, &sAngle, &sDQ);
}

2.4 GMCLIB_Parkinv

The GMCLIB_Parkinv function calculates the Park transformation, which transforms values (flux, voltage, current) from the
rotating two-phase (d-q) orthogonal coordinate system to the stationary two-phase (a-f) coordinate system, according to the
following equations:

a=d-cos(0) — ¢-sin(6)

B=d-sin(6)+ g-cos(6)

where:

» 0 is the position (angle)

2.4.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The result
may saturate.

 Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GMCLIB_Parkinv function are shown in the following table:
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Table 5. Function versions

Function name Input type Output type

Result type

GMCLIB_Parkinv_F16 | GMCLIB_2COOR_DQ_T_F16 * GMCLIB_2COOR_ALBE_T_F16 *

GMCLIB_2COOR_SINCOS_T_F16 *

void

information. The inputs and the output are within the fractional range <-1; 1).

Inverse Park transformation of a 16-bit fractional two-phase rotating system input to a 16-bit fractional
two-phase stationary system, using a 16-bit fractional angle two-component (sin / cos) position

GMCLIB_Parkinv_FLT |GMCLIB_2COOR_DQ_T_FLT * GMCLIB_2COOR_ALBE_T_FLT *

GMCLIB_2COOR_SINCOS_T_FLT *

void

the range <-1.0; 1.0>.

Inverse Park transformation of a 32-bit single precision floating-point two-phase rotating system input
to a 32-bit single precision floating-point two-phase stationary system, using a 32-bit single precision
floating-point angle two-component (sin / cos) position information. The two-phase rotating system

input and the output are within the full 32-bit single-point floating-point range; the angle input is within

2.4.2 Declaration

The available GMCLIB_Parkinv functions have the following declarations:
void GMCLIB ParkInv_F16 (const GMCLIB 2COOR DQ T F16 *psIn, const GMCLIB 2COOR SINCOS T F16
*psAnglePos, GMCLIB 2COOR ALBE T F16 *psOut)

void GMCLIB ParkInv_FLT (const GMCLIB 2COOR DQ T FLT *psIn, const GMCLIB 2COOR_SINCOS_ T FLT
*psAnglePos, GMCLIB 2COOR ALBE T FLT *psOut)

2.4.3 Function use

The use of the GMCLIB_Parkinv function is shown in the following examples:

Fixed-point version:
#include "gmclib.h"

static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB 2COOR DQ T F16 sDQ;
static GMCLIB 2COOR SINCOS T F16 sAngle;

void Isr (void);

void main (void)

{
/* D, Q structure initialization */
sDQ.fl6D = FRAC16(0.0);
sDQ.f16Q = FRAC16(0.0);

/* Angle structure initialization */
sAngle.fl16Sin = FRAC16(0.0);
sAngle.fl6Cos = FRAC16(1.0);
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/* Periodical function or interrupt */

void Isr(void)

{
/* Inverse Park Transformation calculation */
GMCLIB ParkInv F16(&sDQ, &sAngle, &sAlphaBeta);

Algorithms in detail

Floating-point version:
#include "gmclib.h"

static GMCLIB 2COOR ALBE T FLT sAlphaBeta;
static GMCLIB_2COOR _DQ T_FLT sDQ;
static GMCLIB_2COOR_SINCOS_T_FLT sAngle;

void Isr (void);

void main (void)

{
/* D, Q structure initialization */
sDQ.fl1tD = 0.0F;
sDQ.f1tQ = 0.0F;

/* Angle structure initialization */
sAngle.fltSin = 0.0F;
sAngle.fltCos = 1.0F;

/* Periodical function or interrupt */

void Isr (void)

{
/* Inverse Park Transformation calculation */
GMCLIB_ ParkInv_FLT (&sDQ, &sAngle, &sAlphaBeta);

2.5 GMCLIB_DecouplingPMSM

The GMCLIB_DecouplingPMSM function calculates the cross-coupling voltages to eliminate the d-q axis coupling that causes

nonlinearity of the control.

The d-q model of the motor contains cross-coupling voltage that causes nonlinearity of the control. Figure 1 represents the d-q
model of the motor that can be described using the following equations, where the underlined portion is the cross-coupling voltage:

Cp g d, .
Ug=Rvig+ Ligriq+ Ly 0l

p i d .
Ug =R+ igt Lygrig= Ly~ @y ig T 0"y,

where:
* Ug, Ug are the d and q voltages
* ig, iq are the d and q currents
* Ry is the stator winding resistance

* Lq, Lq are the stator winding d and q inductances
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* Wy is the electrical angular speed

* , is the rotor flux constant

1

|

1 .
ld + P| ud : + 1 l

1

|

d
4»§?—> _— >
- controller + Rs + Lgs

C()equ

Weilq

Pl
controller

v

Rs + Lgs

Figure 28. The d-q PMSM model

To eliminate the nonlinearity, the cross-coupling voltage is calculated using the GMCLIB_DecouplingPMSM algorithm, and
feedforwarded to the d and q voltages. The decoupling algorithm is calculated using the following equations:

Uggee=Uq ~ Lq~ 0y ig
Ugdec = Ug+ Ly- Wy Iy

where:
* Ug, Uq are the d and g voltages; inputs to the algorithm
* Uddec» Ugdec are the d and q decoupled voltages; outputs from the algorithm

The fractional representation of the d-component equation is as follows:

=y, — vidLg- . Jmax
Uddec = Uq — Wy " Iq\Lq " Wel max " Tpayx
imax

kq = Lq ) CUEIJVIZDC " Umax

Ugee = Uq ~ Wy~ ig- kg

The fractional representation of the g-component equation is as follows:

= ; Imax
Ugdec = Ug+ 0 ld(Ld * Wel_max* umax)

kd - Ld * Wel_max " Tmax

Ugdee = gt 0g* iy kg

where:

* kg, kq are the scaling coefficients
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* imax is the maximum current
* Umax iS the maximum voltage
* Wel_max IS the maximum electrical speed
The kg and kq parameters must be set up properly.

The principle of the algorithm is depicted in Figure 2:

Decoupling PMSM
iji + Pl uz*i i + iuddeci + 1 ig i
%_ controller | % - i ;E + Rg + Lgs S
R |
' worLgiy! i :
! elqtq. : a)equ !
' WeiLala] ; Wetlq |
g +x- Pl i {tadec | 1 o
controller i i | Rs + Lgs g |

Figure 29. Algorithm diagram

2.5.1 Available versions
This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result may
saturate. The parameters use the accumulator types.

 Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GMCLIB_DecouplingPMSM function are shown in the following table:

Table 6. Function versions

Function name Input/output type Result type
GMCLIB_DecouplingPMSM_F16 Input GMCLIB_2COOR_DQ_T_F16 * void
GMCLIB_2COOR_DQ_T_F16 *

frac16_t
Parameters GMCLIB_DECOUPLINGPMSM_T_A32 *
Output GMCLIB_2COOR_DQ_T_F16 *

The PMSM decoupling with a 16-bit fractional d-q voltage, current inputs, and a 16-bit
fractional electrical speed input. The parameters are 32-bit accumulator types. The output
is a 16-bit fractional decoupled d-q voltage. The inputs and the output are within the range
<-1;1).

Table continues on the next page...
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Table 6. Function versions (continued)

Function name Input/output type Result type

GMCLIB_DecouplingPMSM_FLT Input GMCLIB_2COOR_DQ_T_FLT * void
GMCLIB_2COOR_DQ_T_FLT *

float_t
Parameters GMCLIB_DECOUPLINGPMSM_T_FLT *
Output GMCLIB_2COOR_DQ_T_FLT *

The PMSM decoupling with a 32-bit single precision floating-point d-q voltage, current,
and electrical speed input. The parameters are 32-bit single precision floating-point types.
The output is a 32-bit single precision floating-point decoupled d-q voltage. The inputs
and the output are within the full 32-bit single-point floating-point range.

2.5.2 GMCLIB_DECOUPLINGPMSM_T_A32 type description

Variable name Input type Description
a32KdGain acc32_t Direct axis decoupling parameter. The parameter is within the range <0 ; 65536.0)
a32KqGain acc32_t Quadrature axis decoupling parameter. The parameter is within the range <0 ;
65536.0)

2.5.3 GMCLIB_DECOUPLINGPMSM_T_FLT type description

Variable name Input type Description
fliLd float_t Direct axis inductance parameter. The parameter is a nonnegative value.
fltLq float_t Quadrature axis inductance parameter. The parameter is a nonnegative value.

2.5.4 Declaration
The available GMCLIB_DecouplingPMSM functions have the following declarations:

void GMCLIB DecouplingPMSM F16 (const GMCLIB 2COOR DQ T F16 *psUDQ, const GMCLIB_2COOR DQ T F16
*psIDQ, fracl6 t fl6SpeedEl, const GMCLIB DECOUPLINGPMSM T A32 *psParam,
GMCLIB_2COOR DQ T F16 *psUDQDec)

void GMCLIB DecouplingPMSM FLT (const GMCLIB 2COOR DQ T FLT *psUDQ, const GMCLIB 2COOR DQ T FLT
*psIDQ, float t fltSpeedEl, const GMCLIB DECOUPLINGPMSM T FLT *psParam,
GMCLIB 2COOR DQ T FLT *psUDQDec)

2.5.5 Function use
The use of the GMCLIB_DecouplingPMSM function is shown in the following examples:
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Fixed-point version:
#include "gmclib.h"

static GMCLIB 2COOR DQ T F16 sVoltageDQ;

static GMCLIB_2COOR DQ T F16 sCurrentDQ;

static fracl6 t fl6AngularSpeed;

static GMCLIB DECOUPLINGPMSM T A32 sDecouplingParam;
static GMCLIB 2COOR DQ T F16 sVoltageDQDecoupled;

void Isr (void);

void main (void)

{
/* Voltage D, Q structure initialization */
sVoltageDQ.£f16D FRAC16(0.0) ;
sVoltageDQ.£16Q FRAC16(0.0);

/* Current D, Q structure initialization */
sCurrentDQ.f16D = FRAC16(0.0);
sCurrentDQ.f16Q FRAC16(0.0) ;

/* Speed initialization */
fl6AngularSpeed = FRAC16(0.0);

/* Motor parameters for decoupling Kd = 40, Kg = 20 */
sDecouplingParam.a32KdGain = ACC32(40.0);
sDecouplingParam.a32KgGain = ACC32(20.0);

/* Periodical function or interrupt */
void Isr (void)
{
/* Decoupling calculation */
GMCLIB DecouplingPMSM F16 (&sVoltageDQ, &sCurrentDQ, fl6AngularSpeed,
&sDecouplingParam, &sVoltageDQDecoupled) ;
}

Floating-point version:
#include "gmclib.h"

static GMCLIB_2COOR _DQ T FLT sVoltageDQ;

static GMCLIB 2COOR DQ T FLT sCurrentDQ;

static float t fltAngularSpeed;

static GMCLIB_ DECOUPLINGPMSM T FLT sDecouplingParam;
static GMCLIB 2COOR DQ T FLT sVoltageDQDecoupled;

void Isr(void) ;

void main (void)

{
/* Voltage D, Q structure initialization */
sVoltageDQ.fltD 0.0F;
sVoltageDQ.f1ltQ = 0.0F;
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/* Current D, Q structure initialization */
sCurrentDQ.fltD = 0.0F;
sCurrentDQ.fltQ = 0.0F;

/* Speed initialization */
fltAngularSpeed = 0.0F;

/* Motor parameters for decoupling Kd = 40, Kg = 20 */
sDecouplingParam.fltLd = 40.0F;
sDecouplingParam.fltLg = 20.0F;

}

/* Periodical function or interrupt */
void Isr(void)
{
/* Decoupling calculation */
GMCLIB DecouplingPMSM FLT (&sVoltageDQ, &sCurrentDQ, fltAngularSpeed,
&sDecouplingParam, &sVoltageDQDecoupled) ;

}

2.6 GMCLIB_DTCompLut1D

The GMCLIB_DTCompLut1D function implements dead-time-compensation algorithms that return error voltages from measured
currents, knowing the inverter nonlinearity in the Look-Up Table (LUT). The aim of the GMCLIB_DTCompLut1D function is to
make the inverter and the whole control loop more linear, especially around low-duty cycles, where the dead-time effect is
dominant. The error voltage obtained from GMCLIB_DTCompLut1D has the mostimportant impact in the low-motor-speed region,
where the motor-supply voltage is low. The next operation is to transform the error voltages from the three-phase (a, b, c)
system of coordinates to the two-phase (a, B) orthogonal system using the Clarke transformation. The multiplication by Upcgys
voltages is then processed and the output-compensation voltages are obtained after adding input voltages. The principle of the
GMCLIB_DTCompLut1D function is shown in Figure 30.

la Usrrora
— LUT
ib i, U
—> LUT Clarke errorap aBDTComp
Uerrors transformation
ic
—
UerrorC

Upcpus

[ B

Figure 30. GMCLIB_DTCompLut1D function block scheme

Adding the GMCLIB_DTCompLut1D function into your application has the following essentials. Each inverter introduces the total
error voltage, which is caused by the dead-time and current-clamping effects and the transistor voltage drop. The actual inverter
output voltage is lower than the required voltage. The total error voltage depends on the actual phase current. The example of the
inverter error characteristic is shown in Figure 31.
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Figure 31. Inverter error characteristic example - voltage error dependency on phase current

The inverter error characteristic is assigned to the GMCLIB_DTCompLut1D algorithm as the LUT, which simply adds the
error-voltage vector to the input-voltage vector. The data for the LUT should be measured from a real inverter for the best
compensation result. The target of the measurement is the voltage-error-to-phase-current dependency, as shown in Figure 32.
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Figure 32. Measured inverter voltage error data example for LUT measured for phase current points

The LUT is defined by the table pointer and tableSize parameters. The table output is the error-voltage vector from the
phase-current input vector. The GMCLIB_DTCompLut1D algorithm processes the compensation voltage according to the
following equations:

Ugperror = GFLIB_Lut1D_F16(i, Table, TableSize)
Ugerror = GFLIB_Lut1D_F16(iy, Table, TableSize)
Ucerror = GFLIB_Lut1D_F16(i., Table, TableSize)

Figure 33. Equations to get the error voltages componnents
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where:
* Uperror Berror» @aNd Ucerror @re the error-voltage components of the error-voltage vector.
* ia ip, and i are the current components of the measured-current vector.
* The LUT contains the inverter measured characteristic. See GMCLIB_DTCOMPLUT1D_T_F16 for details.
» The tableSize parameter is the size of the LUT parameter. See GMCLIB_DTCOMPLUT1D_T_F16 for details.
* The GFLIB_Lut1D_F16 parameter is the LUT function (GMCLIB_DTCompLut1D).

When the error voltages are calculated, the GMCLIB_DTCompLut1D algorithm continues using the following equations:

Udcbus

UgpTcomp = Ua + (2 X UpError — UBError — uCErrur) X 3

= V3 X g
uﬁDTComp - uﬁ + (uBError - uCError) X 3 e

Figure 34. DTCompLUT1D function equations

where:
* UabTcomp @nd UgpTcomp are the compensation voltage components and outputs of the GMCLIB_DTCompLut1D function.
* Ug, and ug are the voltage components of the input-voltage vector.
* Uperror UBerrors @Nd Ucerror are the error-voltage components of the error-voltage vector.
* Upcgus is the DC-Bus voltage.

At the end of the GMCLIB_DTCompLut1D algorithm, the error-compensation-voltage componenets (a and ) are added

to the input voltage components (a and ). The addition with saturation is used to avoid overflow and the resuls of the
GMCLIB_DTCompLut1D function are the dead-time-compensated voltage components (Ugptcomp and Ugprcomp) as inputs for
the SVMShifted function.

2.6.1 Available versions
This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result. The result is in the range of <-1 ; 1). The result may saturate.
The parameter inludes the table and table size used the table types.

Table 7. Function versions

Function name Input/output type Result type

GMCLIB_DTCompLut1D_F16 Inputs GMCLIB_3COOR T F16 * void
GMCLIB_2COOR_ALBE_T_F16 *,
frac16_t

Parameter GMCLIB_DTCOMPLUT1D_T_F16 *, *
Output GMCLIB_2COOR_ALBE_T_F16 *

The first input argument is the structure of current components represented by the
16-bit fractional values. It contains the abscissas for which the 1-D interpolations
are performed. The second input argument is the structure of voltage components
represented by the two-phase (a, B) orthogonal coordinate system. The last input
argument is the measured 16-bit fractional DC-Bus voltage input.

Table continues on the next page...
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Table 7. Function versions

Function name Input/output type Result type

The parameter structure consists of two members of the
GMCLIB_DTCOMPLUT1D_T_F16 structure type. The first parameter is the pointer
to the LUT and the second parameter is the size of the LUT.

The ouput argument is the strucrure of compensated voltage components
represented by the two-phase (a, B) orthogonal coordinate system, targeted for the
SVMShifted function.

2.6.2 GMCLIB_LDTCOMPLUT1D_T_F16 type description

Variable name | Input type Description
pf16Table frac16_t* | The pointer to a LUT, which contains the 16-bit fractional values of the LUT.
u16TableSize uint16_t The size of the LUT parameter is in the range of <1 ; 15>. It means that the parameter is
log2 of the number of points + 1.

2.6.3 Declaration
The available GMCLIB_DTCompLut1D functions have the following declarations:
GMCLIB DTCompLutlD F16(const GMCLIB_3COOR_T_F16 *psIABC, const GMCLIB_2COOR_ALBE T _F1l6 *psUAlBe,

fraclé tfl16UDCBus, const GMCLIB DTCOMPLUT1D T F16 *psParam, GMCLIB 2COOR ALBE T F16 *psUAlBeDTComp)

2.6.4 Function use
The use of the GMCLIB_DTCompLut1D function is shown in the following example:

Fixed-point version:

#include "gmclib.h"
static GMCLIB_DTCOMPLUT1D T F16 sParam;
static GMCLIB 3COOR T F16 sIABC;
static GMCLIB_ 2COOR ALBE T F16 sUAlBe, sUAlBeComp;
static fracl6 t f16UDCBus;
static fracl6 t flé6Table[9] = {FRAC16(-0.7), FRAC16(-0.65), FRAC16(-0.55),
FRAC16(0.2), FRAC16(0.0),
FRAC16(0.2), FRAC16(-0.8), FRAC16(0.91),
FRAC16(0.99) };
void Isr (void) ;

void main (void)
{
/* ABC currents structure initialization */
sIABC.f16A = FRACl6(0.1);
sIABC.f16B = FRAC16(0.3);
sIABC.f16C = FRAC1l6(-0.2);
/* Alpha Bete voltages structure initialization */
sUAlBe.fl6Alpha = FRAC16(0.25);
sUAlBe.fl6Beta = FRAC16(0.75);
/* DC Bus voltage initialization */
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f16UDCBus = FRAC16(0.9);
/* DC Bus voltage initialization */
sParam.pfl6Table = flé6Table;
sParam.ul6TableSize = 3;
}
/* Periodical function or interrupt */
void Isr (void)
{
/* Dead-Time compensation calculation */
GMCLIB DTCompLutlD F16 (&sIABC, &sUAlBe, f16UDCBus, &sParam, &sUAlBeComp) ;

2.7 GMCLIB_ElimDcBusRipFOC

The GMCLIB_ElimDcBusRipFOC function is used for the correct PWM duty cycle output calculation, based on the measured
DC-bus voltage. The side effect is the elimination of the the DC-bus voltage ripple in the output PWM duty cycle. This function
is meant to be used with a space vector modulation, whose modulation index (with respect to the DC-bus voltage) is an inverse
square root of 3.

The general equation to calculate the duty cycle for the above-mentioned space vector modulation is as follows:

_ UrocC
UpwM = Tiges “\3

where:
* Upwwm is the duty cycle output
* Upoc is the real FOC voltage
* Ugchus IS the real measured DC-bus voltage

Using the previous equations, the GMCLIB_ElimDcBusRipFOC function compensates an amplitude of the direct-a and the
quadrature-3 component of the stator-reference voltage vector, using the formula shown in the following equations:

0, Up=0 A Ugps=0
Udcbus
L Ugz0 A |Ua|2_\/§
Uy* U gebus
“ -1 Uy<0 A |Ua|z%
Uq
Udcbus ) \/53 else
0’ Uﬁ:O A Udcbus:()
Udcbus
1 Upz0 A |Ug|= g
U *= U cous
£ -1, Up<0 A |Ug|= ‘33”
Ys
Udcbus ) \/5’ clse

where:
* Uy is the direct-a duty cycle ratio
* Ug" is the quadrature-§ duty cycle ratio
* U is the direct-a voltage

* Ug is the quadrature-f voltage
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If the fractional arithmetic is used, the FOC and DC-bus voltages have their scales, which take place in
GMCLIB_ElimDcBusRipFOC_Eqg1; the equation is as follows:

U _ UrocUroc_max \/—
PWM Udcbus'UdcbuxJnax

where:
* Upoc is the scaled FOC voltage
* Ugcpus is the scaled measured DC-bus voltage
* Uroc_max is the FOC voltage scale
* Ugcebus_max 1S the DC-bus voltage scale

If this algorithm is used with the space vector modulation with the ratio of square root equal to 3, then the FOC voltage scale is
expressed as follows :

Udcbm_ma_x
UF OC_max = \E
The equation can be simplified as follows:
U Udcbus max
U _ o\ [z _ Yroc
PWM Udcbus'U dcbus_max Udcbm

The GMCLIB_ElimDcBusRipFOC function compensates an amplitude of the direct-a and the quadrature-g component of the
stator-reference voltage vector in the fractional arithmetic, using the formula shown in the following equations:

0, Uy=0 A Udcbus =0
Us>0 A |Ugl 2 U yopus
U, = -1, Us<O0 A Ul 2 U ypus
Uq
Udcbus’ clse
0, Uﬂ =0 A Udcbus =0
Uﬂ>0 A ‘Uﬁ‘ 2 U gepus
Uﬂ*z -1, Uﬂ<0 AN |Uﬂ|2UdcbuS
Yp
T else

where:
* U," is the direct-a duty cycle ratio
 Ug* is the quadrature-§ duty cycle ratio
* Uq is the direct-a voltage
* Ug is the quadrature-f voltage

The GMCLIB_ElimDcBusRipFOC function can be used in general motor-control applications, and it provides elimination of the
voltage ripple on the DC-bus of the power stage. Figure 1 shows the results of the DC-bus ripple elimination, while compensating
the ripples of the rectified voltage using a three-phase uncontrolled rectifier.
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2.7.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.

» Fractional output with floating-point input - the output is the fractional portion of the result; the result is within the range <-1;

1). The result may saturate. The

The available versions of the GMCLI

Table 8. Function versions

inputs are floating-point values.

B_ElimDcBusRipFOC function are shown in the following table:

Function name Input type Output type Result
type
GMCLIB_EIimDcBusRipFOC_F16 frac16_t GMCLIB_2COOR_ALBE_T_F16 * void

GMCLIB_2COOR_ALBE_T_F16 *

Compensation of a 16-bit fractional two-phase system input to a 16-bit fractional
two-phase system, using a 16-bit fractional DC-bus voltage information. The DC-bus
voltage input is within the fractional range <0 ; 1); the stationary (a-8) voltage input and
the output are within the fractional range <-1 ; 1).

GMCLIB_ElimDcBusRipFOC_F16ff | float_t GMCLIB_2COOR_ALBE_T_F16 * void
GMCLIB_2COOR_ALBE_T_FLT *
Table continues on the next page...
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Function name

Input type Output type Result
type

Compensation of a 32-bit single precision floating-point two-phase system input to a
16-bit fractional two-phase system, using a 32-bit single precision floating-point DC-bus
voltage information. The DC-bus voltage input is a nonnegative value; the two-phase
voltage input is within the full 32-bit single-point floating-point range, and the output is
within the fractional range <-1 ; 1).

2.7.2 Declaration

The available GMCLIB_ElimDcBusRipFOC functions have the following declarations:

void GMCLIB ElimDcBusRipFOC F16 (fracl6 t f16UDCBus, const GMCLIB 2COOR ALBE T F16 *psUAlBe,
GMCLIB 2COOR_ALBE T F16 *psUAlBeComp)

void GMCLIB ElimDcBusRipFOC F16ff (float t f1tUDCBus, const GMCLIB 2COOR _ALBE T FLT *psUAlBe,
GMCLIB 2COOR ALBE T F16 *psUAlBeComp)

2.7.3 Function use

The use of the GMCLIB_ElimDcBusRipFOC function is shown in the following example:

#include "gmclib.h"

void Isr (void) ;

void main (void)

{

void Isr (void)

{

static fracl6é t f16UDcBus;
static GMCLIB 2COOR ALBE T F16 sUAlBe;
static GMCLIB_2COOR ALBE T F16 sUAlBeComp;

/* Voltage Alpha, Beta structure initialization */
sUAlBe.fl6Alpha = FRAC16(0.0);
sUAlBe.fl6Beta = FRAC16(0.0);

/* DC bus voltage initialization */
f16UDcBus = FRAC16(0.8);

/* Periodical function or interrupt */

/* FOC Ripple elimination calculation */
GMCLIB ElimDcBusRipFOC F16 (f16UDcBus, &sUAlBe, &sUAlBeComp) ;
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2.8 GMCLIB_ElimDcBusRip

The GMCLIB_ElimDcBusRip function is used for a correct PWM duty cycle output calculation, based on the measured DC-bus
voltage. The side effect is the elimination of the the DC-bus voltage ripple in the output PWM duty cycle. This function can be used
with any kind of space vector modulation; it has an additional input - the modulation index (with respect to the DC-bus voltage).

The general equation to calculate the duty cycle is as follows:

U _ Yroc
PWM ™ Ugehys " 'mod

where:
* Upww is the duty cycle output
* Upoc is the real FOC voltage
* Ugchus IS the real measured DC-bus voltage
* imod is the space vector modulation index

Using the previous equations, the GMCLIB_ElimDcBusRip function compensates an amplitude of the direct-a and the quadrature-
3 component of the stator-reference voltage vector, using the formula shown in the following equations:

0, Ug=0 A Ugpus=0 V ippq=0

1 Ug>0 A |Ua\z% A g >0

U= Us<O A U252 A G020
% *Liods imod>0

0, Up=0 A Ugeps=0 V ipppq=0

! Ug>0 A |Uﬁ|zlf~j;’;‘“‘ A g >0

Us*= -1, Up<0 A |Uﬂ|2[if’ni;’;“é' A g >0
% “Imod> Imod > 0

where:
» U," is the direct-a duty cycle ratio
* Ug" is the quadrature-§ duty cycle ratio
* Uq is the direct-a voltage
* Ug is the quadrature-B voltage

If the fractional arithmetic is used, the FOC and DC-bus voltages have their scales, which take place in
GMCLIB_ElimDcBusRipFOC_Eq1; the equation is as follows:

U _ UprocUroc max . Uppc UYFOC_max
PwM Udcbus'Udc‘buSimax Lmod Udcbus Udcbu.vimax Lmod

where:
* Upoc is the scaled FOC voltage
* Ugepus is the scaled measured DC-bus voltage
* Uroc_max is the FOC voltage scale

* Ugcbus_max is the DC-bus voltage scale
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Ur OC_max

mod fr = Udcbus_max “Umod

where:

* imodfr iS the space vector modulation index in the fractional arithmetic

The GMCLIB_ElimDcBusRip function compensates an amplitude of the direct-a and the quadrature-g component of the
stator-reference voltage vector in the fractional arithmetic, using the formula shown in the following equations:

0, Us=0 A Ugepus=0 V' imodfr=0
il U,>0 A |Ua|zgi+jfj A imodfr>0
Va* = -1, Uy<0 A |Ua|2§i:);dbf“f A ioafr>0
% *Imod frs Imod fr> 0
0 Up=0 A Uggpus=0 V' imoar=0
L Up>0 A |Uﬁ|zgnd7fbf“j A dod >0
Us™= -1, Up<O A |Ug| 272 A gy >0
Uy .
et Lmod fr> Imod fr> 0

where:

» U," is the direct-a duty cycle ratio

+ Ug* is the quadrature- duty cycle ratio

* Uq is the direct-a voltage

* Ug is the quadrature-f voltage

The GMCLIB_ElIimDcBusRip function can be used in general motor-control applications, and it provides elimination of the voltage
ripple on the DC-bus of the power stage. Figure 1 shows the results of the DC-bus ripple elimination, while compensating the
ripples of the rectified voltage, using a three-phase uncontrolled rectifier.
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Measured Voltage on the DC-Bus
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2.8.1 Available versions

This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result may
saturate. The modulation index is a non-negative accumulator type value.

» Fractional output with floating-point input - the output is the fractional portion of the result; the result is within the range <-1;
1). The result may saturate. The inputs are floating-point values.

The available versions of the GMCLIB_ElIimDcBusRip function are shown in the following table:

Table 9. Function versions

acc32_t

GMCLIB_2COOR_ALBE_T_F16 *

Function name Input type Output type Result
type
GMCLIB_ElimDcBusRip_F16sas frac16_t GMCLIB_2COOR_ALBE_T_F16 * void

Compensation of a 16-bit fractional two-phase system input to a 16-bit fractional
two-phase system using a 16-bit fractional DC-bus voltage information and a 32-bit
accumulator modulation index. The DC-bus voltage input is within the fractional range
<0 ; 1); the modulation index is a non-negative value; the stationary (a-f8) voltage input
and output are within the fractional range <-1; 1).

GMCLIB_ElimDcBusRip_F16fff

float_t GMCLIB_2COOR_ALBE_T_F16 * void

Table continues on the next page...
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Table 9. Function versions (continued)

Function name

Input type Output type Result
type

float_t

GMCLIB_2COOR_ALBE_T_FLT *

Compensation of a 32-bit single precision floating-point two-phase system input to a
16-bit fractional two-phase system using a 32-bit single precision floating-point DC-bus
voltage information and modulation index. The DC-bus voltage and modulation index
inputs are non-negative values; the two-phase voltage input is within the full 32-bit
single-point floating-point range, and the output is within the fractional range <-1; 1).

2.8.2 Declaration

The available GMCLIB_ElimDcBusRip functions have the following declarations:

void GMCLIB ElimDcBusRip Fl6sas(fraclé t £16UDCBus, acc32 t a32IdxMod, const GMCLIB 2COOR ALBE T F16

*psUAlBeComp, GMCLIB_2COOR_ALBE T F1l6 *psUAlBe)

void GMCLIB ElimDcBusRip F16fff (float t f1tUDCBus, float t fltIdxMod, const GMCLIB 2COOR ALBE T FLT

*psUAlBeComp, GMCLIB 2COOR ALBE T F16 *psUAlBe)

2.8.3 Function use

The use of the GMCLIB_ElimDcBusRip function is shown in the following example:

#include "gmclib.h"

static fracl6é t f16UDcBus;

static acc32 t a32IdxMod;

static GMCLIB 2COOR ALBE T F16 sUAlBe;
static GMCLIB_2COOR ALBE T F16 sUAlBeComp;

void Isr (void) ;

void main (void)

{
/* Voltage Alpha, Beta structure initialization */
sUAlBe.fl6Alpha = FRAC16(0.0);
sUAlBe.fl6Beta = FRAC16(0.0);

/* SVM modulation index */
a32IdxMod = ACC32(1.3);

/* DC bus voltage initialization */
f16UDcBus = FRAC16(0.8);

/* Periodical function or interrupt */
void Isr(void)

{

/* Ripple elimination calculation */
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GMCLIB ElimDcBusRip Flé6sas (f16UDcBus, a32IdxMod, &sUAlBe, &sUAlBeComp) ;
}

2.9 GMCLIB_SvmStdShifted

The GMCLIB_SvmStdShifted function is based on the GMCLIB_SvmStd function and calculates the appropriate duty-cycle
ratios, which are needed to generate the given stator-reference voltage vector using a special standard space-vector modulation
technique. The GMCLIB_SvmStdShifted function enables the single-shunt measurement and current reconstruction and provides
the data sturctures to configure the ADC and PWM peripherals.

The PWM signal generation by the GMCLIB_SvmStdShifted function applies a four-voltage vector in each PWM period:

» Two of them are inactive — vectors VO (all switch elements are OFF — 000 states) and V7 (all switch elements are ON —
111 states).

» Two of them are active vectors that generate the motor power. See the table in Figure 37.

Two phase currents are normally available as the DC-Bus current (/y.,) during the active voltage vectors in each PWM period. It
is possible to reconstruct all phase currents by measuring two different samples of /s, in each PWM period. The jy¢, currentis 0
during VO and V7. It can be used for offset measurement.
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Figure 37. Single-shunt current reconstruction principle by GMCLIB_SvmStdShifted

Two different phase-current samples cannot be taken when:

» The voltage vector is crossing the SVM sector border. Only one sample can be taken.

» The modulation index is low. The sampling intervals are too short and no current samples can be taken.

There are many solutions available for these problems. For this function, the shifted-PWM method was used:

» The ON/OFF times are modified (shifted), if necessary.

» The duty cycles are preserved (the applied stator voltage is the same).
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Figure 38. Problematic current reconstruction cases

A different shifting strategy is applied for both critical cases:
1. Passing active vector:
* Freezes the center edge.
* Moves one critical edge.
« Itis used for higher modulation indexes.
2. Low modulation indexes:
* Freezes the center edge.
* Moves both side edges in opposite directions.
* Itis used for low modulation indexes.

The right method is selected within the SVM algorithm and shifts are applied by the PWM driver.
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Figure 39. PWM shifting principle for passing active vector and low modulation indexes cases

2.9.1 Available versions

This function is available in the following versions:

« Fractional output - the duty-cycle outputs are the fractional portion of the result. The result is within the range of <0 ; 1). The

result may saturate.

Table 10. Function versions

Function name Input/Output type Result
type
GMCLIB_SvmStdShiffted_F16 | Inputs GMCLIB_2COOR_ALBE_T_F16 *, void
Parameter GMCLIB_SVMSTDSHIFTED_T_F16 *
Outputs GMCLIB_ADC_CONFIG_T_F16 *,
GMCLIB_PWM_CONFIG_T_F16 *

Standard shiffted space vector modulation with a 16-bit fractional

stationary (a-B) input. The parameter is pointed to by an input pointer.

The ouputs are pointed to by output pointers. The result type is a
void type.
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2.9.1.1 GMCLIB_SVMSTDSHIFTED_T_F16 type description
The input to configure the structure for the GMCLIB_SvmStdShifted function.

Variable name | Input type Description

f16LowerLim frac16_t Low PWM duty-cycle limit. It influences any duty-cycle output in the sDuty structure of
the PWM configuration structure. This parameter must be lower than f16UpperLim and of
positive value within the range of <0 ; 1) as well. It is set by the user.

f16UpperLim uint16_t High PWM duty-cycle limit. It influences any duty-cycle output in the sDuty structure of the
PWM configuration structure. This parameter must be higher than f16LowerLim and the
value must be within the range of <0 ; 1) as well. It is set by the user.

f16MinT1T2 uint16_t Minimum T1 or T2 time for a sufficient shift. It influences any shift output in the sShift
structure of the PWM configuration structure. This parameter must be of a positive value and
within the range of <0 ; 1). It is set by the user.

2.9.2 GMCLIB_ADC_CONFIG_T_F16 type description

The output structure to configure the ADC peripheral.

Variable name Input type Description
ui16SectorSVM uint16_t The output sector is an integer value within the range of <1 ; 6>.
It is calculated by the algorithm and targeted to configure the ADC
module.
f16SmplFirstEdge frac16_t The output delay for the first edge sample measurement. It is a

16-bit fractional value within the range of <-1; 1). It is calculated by
the algorithm and targeted to configure the ADC module.

f16SmplSecondEdge frac16_t The output delay for the second sample measurement. It is a 16-bit
fractional value within the range of <-1 ; 1). It is calculated by the
algorithm and targeted to configure the ADC module.

eSmplOnePh GMCLIB_PHASE_INDEX_T | The output value sets the first sample channel (phase) index. It
is assigned from the algorithms and the enumeration value marks
phase A, B, or C.

eSmplTwoPh GMCLIB_PHASE_INDEX_T | The output value sets the second sample channel (phase) index. It
is assigned from the algorithms and the enumeration value marks
phase A, B, or C.

eCalcPh GMCLIB_PHASE_INDEX_T | The output value sets the calculated sample channel (phase)
index. It is assigned from the algorithms and the enumeration value
marks phase A, B, or C.

2.9.3 GMCLIB_PWM_CONFIG_T_F16 type description

The output structure to configure the PWM peripheral.
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Variable name Input type Description

sDuty f16A frac16_t The phase-A duty cycle is a 16-bit fractional value within the range of <0 ;
1). It is calculated by the algorithms and targeted to configure the PWM
module. It may be limited by upper or lower limits.

f16B frac16_t The phase-B duty cycle is a 16-bit fractional value within the range of <0 ;
1). It is calculated by the algorithms and targeted to configure the PWM
module. It may be limited by upper or lower limits.

f16C frac16_t The phase-C duty cycle is a 16-bit fractional value within the range of <0 ;
1). It is calculated by the algorithms and targeted to configure the PWM
module. It may be limited by upper or lower limits.

sShift f16A frac16_t The phase-A shift is a 16-bit fractional value within the range of <-1 ; 1). It
is calculated by the algorithms and targeted to configure the PWM module.

f16B frac16_t The phase-B shift is a 16-bit fractional value within the range of <-1 ; 1). It
is calculated by the algorithms and targeted to configure the PWM module.

f16C frac16_t The phase-C shift is a 16-bit fractional value within the range of <-1; 1). It
is calculated by the algorithms and targeted to configure the PWM module.

2.9.4 GMCLIB_PHASE_INDEX_T type description
The enum data type for labeling the phases in the GMCLIB_ADC_CONFIG_T_F16 structure.

Name Value Description
kPhaseA ou Phase A
kPhaseB 1U Phase B
kPhaseC 2U Phase C

2.9.5 Declaration
The available GMCLIB_SvmStdShifted function has the following declaration:

void GMCLIB SvmStdShifted F16(const GMCLIB 2COOR ALBE T F16 *psIn, const GMCLIB SVMSTDSHIFTED T F16
*psParam, GMCLIB_ADC_CONFIG T _F16 *psCfgMeas, GMCLIB_PWM CONFIG T _F16 *psCfgPWM)

2.9.6 Function use
The use of the GMCLIB_SvmStdShifted function is shown in the following example:

Fixed-point version:
#include "gmclib.h"
static GMCLIB 2COOR ALBE T F16 sAlphaBetaln;
static GMCLIB SVMSTDSHIFTED T F16 sParam;
static GMCLIB ADC CONFIG T F16 sCfgMeas;

static GMCLIB PWM CONFIG T F16 sCEgPWM;

void Isr (void);
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void main (void)

{

sParam.flé6LowerLim

sParam. fl6UpperLim

sParam.f16MinT1T2
}

void Isr (void)

{

/* Alpha, Beta voltage inputs */
sAlphaBetaln.fl6Alpha
sAlphaBetaln.fl6Beta
/* Set SvmStdShifted parameter */

= FRAC16(0.25);
= FRAC16(0.1)

FRAC16(0.01) ;
FRAC16(0.9);
FRAC16(0.1);

/* Periodical function or interrupt */

/* SVM calculation update the output structures sCfgMeas and sCEPWM
to confugure the ADC and PWM modules */
GMCLIB SvmStdShifted F16 (&sAlphaBetaln, &sParam, &sCfgMeas,

&sCEgPWM) ;

Algorithms in detail

2.10 GMCLIB_SvmStd

The GMCLIB_SvmStdfunction calculates the appropriate duty-cycle ratios, which are needed for generation of the given
stator-reference voltage vector, using a special standard space vector modulation technique.

The GMCLIB_SvmStd function for calculating the duty-cycle ratios is widely used in modern electric drives. This function
calculates the appropriate duty-cycle ratios, which are needed for generating the given stator reference voltage vector, using a
special space vector modulation technique, called standard space vector modulation.

The basic principle of the standard space vector modulation technique can be explained using the power stage diagram shown

in Figure 1.

ts

N SBt

< | la Sab% ol Bz
UaB

o - N

Figure 40. Power stage schematic diagram
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The top and bottom switches are working in a complementary mode; for example, if the top switch St is on, then the corresponding
bottom switch Sy, is off, and vice versa. Considering that the value 1 is assigned to the ON state of the top switch, and value

0 is assigned to the ON state of the bottom switch, the switching vector [a, b, ¢]T can be defined. Creating of such vector
allows for numerical definition of all possible switching states. Phase-to-phase voltages can then be expressed in terms of the
following states:

Us 1 -1 0
Usc _UDCBm‘ o 1 - ][Z]
C.

Ucs -1 0 1

where Upcpys is the instantaneous voltage measured on the DC-bus.

Assuming that the motor is completely symmetrical, it is possible to write a matrix equation, which expresses the motor phase
voltages shown in GMCLIB_SvmStd_Eq1.

P U 2 -1 -1
Ub= DCBus -1 2 _ [Z]
U, -1 -1 2]l

In a three-phase power stage configuration (as shown in Figure 1), eight possible switching states (shown in Figure 2) are feasible.
These states, together with the resulting instantaneous output line-to-line and phase voltages, are listed in Table 1.

Table 11. Switching patterns

A|B|C U, Up U Uas Ugc Uca Vector
0|00 0 0 0 0 0 0 Oo00
11010 2Upcaus/3 -Upcaus/3 -Upcaus/3 Ubcaus 0 -UpcBus Uo
11110 Ubcaus/3 Ubcaus/3 -2Upcsus/3 0 Ubcsus -Upceus Uso
0|1]0 -Upceus/3 2Upcsus/3 -Ubcsus/3 -Ubcsus Ubcaus 0 Ui20
0|11 -2UpcBus/3 Ubcaus/3 Ubcaus/3 -Upcsus 0 Ubcsus Uz40
0101 -Upceus/3 -Upceus/3 2Upcaus/3 0 -Ubcaus Ubceus Usoo
1101 Ubcaus/3 -2Upcaus/3 Ubcaus/3 Ubcaus -Upcaus 0 Usso
11111 0 0 0 0 0 0 O111

The quantities of the direct-a and the quadrature-B components of the two-phase orthogonal coordinate system, describing the
three-phase stator voltages, are expressed using the Clark transformation, arranged in a matrix form:

B

1

2
)
2

The three-phase stator voltages - U,, Up, and U, are transformed using the Clark transformation into the direct-a and the
quadrature- components of the two-phase orthogonal coordinate system. The transformation results are listed in Table 2.

Table 12. Switching patterns and space vectors

Table continues on the next page...

GMCLIB User's Guide, Rev. 5, 01 November 2021

A B C Ul Ug Vector
0 0 0 0 0 Oooo
1 0 0 2UpcBus/3 0 Ug

User Guide

55/98



NXP Semiconductors

Algorithms in detail

Table 12. Switching patterns and space vectors (continued)

A B © Uq Us Vector
1 1 0 Ubceus/3 Upcaus/V3 Uso
0 1 0 -Upcpus/3 Upceus/V3 U120
0 1 1 -2UpcBus/3 0 Uz40
0 0 1 -Upcpus/3 -Upcaus/V3 Usoo
1 0 1 Upcius/3 -Upceus/V3 Useo
1 1 1 0 0 O111

Figure 2 depicts the basic feasible switching states (vectors). There are six nonzero vectors - Uy, Ugg,U129, U1g0, U240, and Usqg,
and two zero vectors - O441 and Oygg, usable for switching. Therefore, the principle of the standard space vector modulation lies
in applying the appropriate switching states for a certain time, and thus generating a voltage vector identical to the reference one.

U120 U5°
(010) (110)
[1/73,-1] [1/3,1]

U, Ii. l U,
(011) (100)
[-2/7/3,0] < P [2/73,0]
IV. VI.
U24o U300
(001) (101)
[-1/73,-1] [-1/7/3,1]

Figure 41. Basic space vectors

Referring to this principle, the objective of the standard space vector modulation is an approximation of the reference stator voltage
vector Ug, with an appropriate combination of the switching patterns, composed of basic space vectors. The graphical explanation
of this objective is shown in Figure 3 and Figure 4.
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U1ZD
(010)
[1K3,-1]

B-axis

Sector Number

Maximal phase
voltage magnitude = 1

Umu UD
(011) (100) o-axis
[-243,0] [243,0]

[-1W3,-1]
Uon
(001)

-113,1]
UBU(}
(101)

Figure 42. Projection of reference voltage vector in the respective sector

The stator reference voltage vector Ug is phase-advanced by 30° from the direct-a, and thus can be generated with an appropriate
combination of the adjacent basic switching states Ug and Ugq. These figures also indicate the resultant direct-a and quadrature-8
components for space vectors Uy and Ugg.
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USD
(110
[1~3,1]
Il. Sector Number
Teo T"Ugo 60 degrees /

2n3*u,

(100) g-axis

7— [2A3,0]

TJ/T*U, 1N3*u,

30 degrees | VL.

Figure 43. Detail of the voltage vector projection in the respective sector

In this case, the reference stator voltage vector Ug is located in sector |, and can be generated using the appropriate duty-cycle
ratios of the basic switching states Uy and Ugg. The principal equations concerning this vector location are as follows:

T=T60+T0+T

null

_Tgo Ty
Us=7 -UgotT Uy

where Tgg and Ty are the respective duty-cycle ratios, for which the basic space vectors Tgg and Tg should be applied within the
time period T. T is the time, for which the null vectors Oggg and O414 are applied. Those duty-cycle ratios can be calculated using
the following equations:

=" U] sin60°

up
tan60°

uaz% |UA+

Considering that normalized magnitudes of basic space vectors are |Ugo| = |Ug| = 2/ /3, and by the substitution of the trigonometric
expressions sin 60° and tan 60° by their quantities 2 / V3, and 3, respectively, the GMCLIB_SvmStd_Eq5 can be rearranged for
the unknown duty-cycle ratios Tgg / T and Ty / T as follows:

Teo _
T ~Up

_ T Te0
Us=—7 "Uppt7 Uso
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Sector Il is depicted in GMCLIB_SvmStd_Img>5. In this particular case, the reference stator voltage vector Ug is generated using
the appropriate duty-cycle ratios of the basic switching states Tgg and T15o. The basic equations describing this sector are
as follows:

T=T0tTetT,

null

_ Ty )
Us=—7 "Upt7 Uso

where T159 and Tgq are the respective duty-cycle ratios, for which the basic space vectors U455 and Ugg should be applied within
the time period T. T, is the time, for which the null vectors Ogqg and O444 are applied. These resultant duty-cycle ratios are
formed from the auxiliary components, termed A and B. The graphical representation of the auxiliary components is shown

in GMCLIB_SvmStd_Img6.

Uwzu Uso
(010) B-axis (110)
[1N3,-1] [N3,1]

Sector Number

Maximal phase
voltage magnitude = 1

U
(100) o-axis
[2/43,0]

[-1¥3.-1] [F13,1]
U24CI 300

(001) (101)

Figure 44. Projection of the reference voltage vector in the respective sector
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60 degrees

[1~3,-1] [1~3,1]

30 degrees
Teo T*Ug,

Sector Number
120 degrees B=u,

A=1N3*u,  o-axis

Figure 45. Detail of the voltage vector projection in the respective sector

The equations describing those auxiliary time-duration components are as follows:

sin30° _ 4
sin120° Y4B
5in60° _B

sin60°  Ya

Equations in GMCLIB_SvmStd_Eq8 have been created using the sine rule.

The resultant duty-cycle ratios T45¢/ T and Tgg / T are then expressed in terms of the auxiliary time-duration components, defined

by GMCLIB_SvmStd_Eq9as follows:

_ 1
A_\E u/}
B=u,

Using these equations, and also considering that the normalized magnitudes of the basic space vectors are |U4o9| = |Ugo| =2/+3,
the equations expressed for the unknown duty-cycle ratios of basic space vectors T159/ T and Tgg / T can be expressed as follows:

T

2 -U,d=(4-B)
T

- -|Ugd=(4+B)

The duty-cycle ratios in the remaining sectors can be derived using the same approach. The resulting equations will be similar to

those derived for sector | and sector Il.
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T
=y u)

T
% =—é(uﬂ+ 3 - uy)

To depict the duty-cycle ratios of the basic space vectors for all sectors, we define:

» Three auxiliary variables:

X:uﬂ
Y =3up+\3 g
Z=3s—\3 o)

» Two expressions - t_1 and t_2, which generally represent the duty-cycle ratios of the basic space vectors in the respective
sector (for example, for the first sector, t_1 and t_2), represent duty-cycle ratios of the basic space vectors Ugg and Ug; for the
second sector, t_1 and t_2 represent duty-cycle ratios of the basic space vectors U459 and Ugg, and so on.

The expressions t_1 and t_2, in terms of auxiliary variables X, Y, and Z for each sector, are listed in Table 3.

Table 13. Determination of t_1 and t_2 expressions

Sectors Uo. Ugo Uso. U120 U120, U1so U1go, U240 U240, U3oo Usoo, Uo
t 1 X Y -Y Z -Z -X
t 2 -Z X -X -Y Y

For the determination of auxiliary variables X, Y, and Z, the sector number is required. This information can be obtained using
several approaches. The approach discussed here requires the use of modified Inverse Clark transformation to transform

the direct-a and quadrature- components into balanced three-phase quantities Urefq, Urefz, and upers, used for straightforward
calculation of the sector number, to be shown later.

Uref1 = Up
—ugt \Ig'“a
Upe 12 = 2
up \Ig"”a
Upe 13 == 2

The modified Inverse Clark transformation projects the quadrature-ug component into U1, as shown in GMCLIB_SvmStd_Img7
and GMCLIB_SvmStd_Img8, whereas voltages generated by the conventional Inverse Clark transformation project the direct-uq
component into Uyef.
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amplitude

Components of the Stator Reference Voltage Vector
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Figure 46. Direct-u, and quadrature-u, components of the stator reference voltage

GMCLIB_SvmStd_Img7 depicts the direct-uy and quadrature-ug components of the stator reference voltage vector Us, which were

calculated using equations

Ug = cos & and ug = sin 3§, respectively.

amplitude

Sinusoidal Three-Phase Reference Voltage

1
0.8
0.6 X X X
041 /7 /N /N
0.2
02
-0. N V4
-04 ></ \>< w— uref1
-0.6 uref2
-0.8 uref3 R

-1 T
0 60 120 180 240 300 360
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angle

Figure 47. Reference voltages Uief1, Urer2, and Upess

The sector identification tree shown in GMCLIB_SvmStd_Img9 can be a numerical solution of the approach shown

in GMCLIB_SvmStd_Img8.

GMCLIB User's Guide, Rev. 5, 01 November 2021

User Guide

62 /98



NXP Semiconductors

Algorithms in detail

/\

Uref3 < 0 Uref3 > 0
Uref2 > 0 Uref2 = 0 Uref2 > 0 Uref2 < 0
Uref1 = 0 Ureft = 0 Uref1 = 0 Uref1 > 0
Sector = VI Sector =1 Sector =1l Sector =V Sector = IV Sector = Il

Figure 48. Identification of the sector number

In the worst case, at least three simple comparisons are required to precisely identify the sector of the stator reference voltage

vector. For example, if the stator reference voltage vector is located as shown in GMCLIB_SvmStd_Img3, the stator-reference

voltage vector is phase-advanced by 30° from the direct a-axis, which results in the positive quantities of u,ey and uesp, and the
negative quantity of u.f3; see GMCLIB_SvmStd_Img8. If these quantities are used as the inputs for the sector identification tree,
the product of those comparisons will be sector . The same approach identifies sector I, if the stator-reference voltage vector is
located as shown in GMCLIB_SvmStd_Img5. The variables t4, t,, and t3, which represent the switching duty-cycle ratios of the

respective three-phase system, are calculated according to the following equations:

Tt 12
h=—""

L=t;+1 1
t=ty+t 2

where T is the switching period, and t_1 and t_2 are the duty-cycle ratios of the basic space vectors given for the respective
sector; Table 3, GMCLIB_SvmStd_Eq3, and GMCLIB_SvmStd_Eq15 are specific solely to the standard space vector modulation
technique; other space vector modulation techniques discussed later will require deriving different equations.

The next step is to assign the correct duty-cycle ratios - t4, tp, and ts, to the respective motor phases. This is a simple task,
accomplished in a view of the position of the stator reference voltage vector; see .

Table 14. Assignment of the duty-cycle ratios to motor phases

Sectors Uo, Ueo Ueo, U120 U120, U1so U1go, Uzao U240, Usoo Usg0, Uo
pwm_a t3 to t4 t4 3 t3
pwm_b to t3 t3 to t4 4
pwm_c 4 Y to t3 t3 to

The principle of the space vector modulation technique consists of applying the basic voltage vectors Uyxx and Oxxx for certain
time, in such a way that the main vector generated by the pulse width modulation approach for the period T is equal to the original
stator reference voltage vector Ug. This provides a great variability of arrangement of the basic vectors during the PWM period T.
These vectors might be arranged either to lower the switching losses, or to achieve diverse results, such as center-aligned PWM,
edge-aligned PWM, or a minimal number of switching states. A brief discussion of the widely used center-aligned PWM follows.

Generating the center-aligned PWM pattern is accomplished by comparing the threshold levels pwm_a, pwm_b, and pwm_c with
afree-running up-down counter. The timer counts to one, and then down to zero. Itis supposed that when a threshold level is larger
than the timer value, the respective PWM output is active. Otherwise, it is inactive; see GMCLIB_SvmStd_Img10.
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Center-Aligned PWM
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Figure 49. Standard space vector modulation technique — center-aligned PWM
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GMCLIB_SvmStd_Img11 shows the waveforms of the duty-cycle ratios, calculated using standard space vector modulation.

For the accurate calculation of the duty-cycle ratios, direct-a, and quadrature-8 components of the stator reference voltage
vector, it must be considered that the duty cycle cannot be higher than one (100 %); in other words, the assumption

must be met.

Jo2+ B2 <1
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Figure 50. Standard space vector modulation technique
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2.10.1 Available versions

This function is availabl

e in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmStd function are shown in the following table.

Table 15. Function versions

Function name

Input type Output type Result type

GMCLIB_SvmStd_F16

GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_3COOR_T_F16 * uint16_t

Standard space vector modulation with a 16-bit fractional stationary (a-f) input and a 16-bit fractional
three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual SVM
sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1). The
output sector is an integer value within the range <1 ; 6>.

2.10.2 Declaration

The available GMCLIB_

SvmStd functions have the following declarations:

uintl6 t GMCLIB SvmStd F16(const GMCLIB 2COOR ALBE T F16 *psIn, GMCLIB 3COOR T F16 *psOut)
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2.10.3 Function use

The use of the GMCLIB_SvmStd function is shown in the following example:

#include "gmclib.h"

static uintl6 t ul6Sector;
static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB 3COOR T F16 sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

/* Periodical function or interrupt */
void Isr(void)
{
/* SVM calculation */
ul6Sector = GMCLIB SvmStd F16(&sAlphaBeta, &sAbc);

2.11 GMCLIB_Svmict

The GMCLIB_Svmictfunction calculates the appropriate duty-cycle ratios, which are needed for generation of the given
stator-reference voltage vector using the general sinusoidal modulation technique.

The GMCLIB_Svmict function calculates the appropriate duty-cycle ratios, needed for generation of the given stator reference
voltage vector using the conventional Inverse Clark transformation. Finding the sector in which the reference stator voltage vector
Us resides is similar to GMCLIB_SvmStd. This is achieved by first converting the direct-a and the quadrature- components of
the reference stator voltage vector Ug into the balanced three-phase quantities Ueef1, Urer2, @and Uesz Using the modified Inverse
Clark transformation:

Upef1 = Up
*ul,rﬂﬁ Ug
Upef2 = 2
_ g \E'”a
uref 37 2

The calculation of the sector number is based on comparing the three-phase reference voltages Uyef1, Urer2, and Uyesz With zero.
This computation is described by the following set of rules:

{1’ Mref1>0
a=

0, else
b {2, Upef2> 0

0, else

4, Urer3>0
€= {0, else

After passing these rules, the modified sector numbers are then derived using the following formula:
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sector*=a+b+c

The sector numbers determined by this formula must be further transformed to correspond to those determined by the sector
identification tree. The transformation which meets this requirement is shown in the following table:

Table 16. Transformation of the sectors

Sector*

1

Sector

2

Use the Inverse Clark transformation for transforming values such as flux, voltage, and current from an orthogonal rotating
coordination system (ug, Ug) to a three-phase rotating coordination system (u,, Up, and uc). The original equations of the Inverse
Clark transformation are scaled here to provide the duty-cycle ratios in the range <0 ; 1). These scaled duty cycle ratios pwm_a,

pwm_b, and pwm_c can be used directly by the registers of the PWM block.

Ug
pwm_a=0.5+%
pwm_b=0.5+——7F—

pwm_c=05+—5—

The following figure shows the waveforms of the duty-cycle ratios calculated using the Inverse Clark transformation.

Figure 51. Inverse Clark transform modulation technique
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For an accurate calculation of the duty-cycle ratios and the direct-a and quadrature-g components of the stator
reference voltage vector, the duty cycle cannot be higher than one (100 %); in other words, the assumption

ya2+ f <1

must be met.

2.11.1 Available versions
This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_Svmict function are shown in the following table:

Table 17. Function versions

Function name Input type Output type Result type
GMCLIB_Svmlct_F16 GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_3COOR_T_F16 * uint16_t

General sinusoidal space vector modulation with a 16-bit fractional stationary (a-B) input and a 16-bit
fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual
SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1).
The output sector is an integer value within the range <1 ; 6>.

2.11.2 Declaration

The available GMCLIB_Svmict functions have the following declarations:

uintlé t GMCLIB SvmIct F16(const GMCLIB 2COOR ALBE T F16 *psIn, GMCLIB 3COOR T F16 *psOut)

2.11.3 Function use

The use of the GMCLIB_Svmict function is shown in the following example:

#include "gmclib.h"

static uintl6 t ul6Sector;
static GMCLIB_ 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB_3COOR_T_F1l6 sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

}

/* Periodical function or interrupt */
void Isr(void)
{
/* SVM calculation */
ul6Sector = GMCLIB SvmIct F16(&sAlphaBeta, &sAbc);
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2.12 GMCLIB_SvmUOn

The GMCLIB_SvmUOnfunction calculates the appropriate duty-cycle ratios, which are needed for generation of the given
stator-reference voltage vector using the general sinusoidal modulation technique.

The GMCLIB_SvmUOn function for calculating of duty-cycle ratios is widely used in modern electric drives. This function calculates
the appropriate duty-cycle ratios, which are needed for generating the given stator reference voltage vector using a special space
vector modulation technique called space vector modulation with Oggqg nulls, where only one type of null vector Ogqq is used (all
bottom switches are turned on in the invertor).

The derivation approach of the space vector modulation technique with Oggg nulls is in many aspects identical to the approach
presented in GMCLIB_SvmStd. However, a distinct difference lies in the definition of the variables t4, t,, and t3 that represent
switching duty-cycle ratios of the respective phases:

1=0
L=t +t_1
ty=t,+t_ 2

where T is the switching period, and t_1 and t_2 are the duty-cycle ratios of the basic space vectors that are defined for the
respective sector in Table 2-7.

The generally used center-aligned PWM is discussed briefly in the following sections. Generating the center-aligned PWM pattern
is accomplished practically by comparing the threshold levels pwm_a, pwm_b, and pwm_c with the free-running up/down counter.
The timer counts up to 1 (Ox7FFF) and then down to 0 (0x0000). It is supposed that when a threshold level is larger than the timer
value, the respective PWM output is active. Otherwise it is inactive (see GMCLIB_SvmUOn_Img1).

Centre-Aligned PWM

Il

pwm_a _l
pwm_b _|
pwm_c, _l

PHASE_A § =2} o2 |

PHASE B i T=p2

PHASE_C

UGD UD ODDD ODDD ODDU ODDD UU
(110)1(100)! (000)} (000) (000) | (000)} (100)

Sector .

USI]
(110)

Figure 52. Space vector modulation technique with Oggg nulls — center-aligned PWM
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Figure GMCLIB_SvmUOn_lmg1 shows calculated waveforms of the duty cycle ratios using space vector modulation with
0000 nulls.

For an accurate calculation of the duty-cycle ratios, direct-a, and quadrature-g components of the stator reference
voltage vector, consider that the duty cycle cannot be higher than one (100 %); in other words, the assumption

\/a2+ﬂ2 <1

must be met.

Components of the Stator Reference Voltage Vector
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Figure 53. Space vector modulation technique with Ogg nulls

2.12.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmUOn function are shown in the following table:

Table 18. Function versions

Function name Input type Output type Result type
GMCLIB_SvmUOn_F16 |GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_3COOR_T_F16 * uint16_t

General sinusoidal space vector modulation with a 16-bit fractional stationary (a-8) input, and a 16-bit
fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual

Table continues on the next page...
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Table 18. Function versions

Function name Input type Output type Result type

SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1).
The output sector is an integer value within the range <1 ; 6>.

2.12.2 Declaration

The available GMCLIB_SvmUOn functions have the following declarations:

uintl6 t GMCLIB SvmUOn_ F16 (const GMCLIB 2COOR ALBE T F16 *psIn, GMCLIB 3COOR T F16 *psOut)

2.12.3 Function use

The use of the GMCLIB_SvmUOn function is shown in the following example:

#include "gmclib.h"

static uintl6 t ul6Sector;
static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB 3COOR T F16 sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

/* Periodical function or interrupt */
void Isr(void)
{
/* SVM calculation */
ul6Sector = GMCLIB SvmUOn F16(&sAlphaBeta, &sAbc);

2.13 GMCLIB_SvmUT7n

The GMCLIB_SvmU7n function calculates the appropriate duty-cycle ratios, which are needed for generation of the given
stator-reference voltage vector, using the general sinusoidal modulation technique.

The GMCLIB_SvmU7n function for calculating the duty-cycle ratios is widely used in modern electric drives. This function
calculates the appropriate duty-cycle ratios, which are needed for generating the given stator reference voltage vector using a
special space vector modulation technique called space vector modulation with O444 nulls, where only one type of null vector O444
is used (all top switches are turned on in the invertor).

The derivation approach of the space vector modulation technique with O¢44 nulls is identical (in many aspects) to the approach
presented in GMCLIB_SvmStd. However, a distinct difference lies in the definition of variables t4, tp, and t3 that represent switching
duty-cycle ratios of the respective phases:
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L=

T-t 1-t 2

L=t+t_1
ty=t,+t_ 2

where T is the switching period, and t_1 and t_2 are the duty-cycle ratios of the basic space vectors defined for the respective

sector in Table 2-7.

The generally-used center-aligned PWM is discussed briefly in the following sections. Generating the center-aligned PWM pattern
is accomplished by comparing threshold levels pwm_a, pwm_b, and pwm_c with the free-running up/down counter. The timer

counts up to 1 (0x7FFF) and then down to 0 (0x0000). It is supposed that when a threshold level is larger than the timer value,
the respective PWM output is active. Otherwise, it is inactive (see GMCLIB_SvmU7n_Img1).

Centre-Aligned PWM

Figure 54. Space vector modulation technique with O441 nulls — center-aligned PWM
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Figure GMCLIB_SvmU7n_lmg1 shows calculated waveforms of the duty-cycle ratios using Space Vector Modulation with

0111 nulls.

For an accurate calculation of the duty-cycle ratios, direct-a, and quadrature-g components of the stator reference voltage
vector, it must be considered that the duty cycle cannot be higher than one (100 %); in other words, the assumption

Jo2+ f2 <1

must be met.
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Components of the Stator Reference Voltage Vector
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Figure 55. Space vector modulation technique with O144 nulls

2.13.1 Available versions
This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmU7n function are shown in the following table:

Table 19. Function versions

Function name Input type Output type Result type
GMCLIB_SvmU7n_F16 | GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_3COOR_T_F16 * uint16_t

General sinusoidal space vector modulation with a 16-bit fractional stationary (a-8) input and a 16-bit
fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual
SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1).
The output sector is an integer value within the range <1 ; 6>.

2.13.2 Declaration

The available GMCLIB_SvmU7n functions have the following declarations:

uintl6é_t GMCLIB SvmU7n_F16 (const GMCLIB 2COOR ALBE T F16 *psIn, GMCLIB 3COOR T F16 *psOut)
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2.13.3 Function use

The use of the GMCLIB_SvmU7n function is shown in the following example:

#include "gmclib.h"

static uintl6 t ul6Sector;
static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB 3COOR T F16 sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0) ;
sAlphaBeta.fl6Beta = FRAC16(0.0);

/* Periodical function or interrupt */
void Isr(void)
{
/* SVM calculation */
ul6Sector = GMCLIB SvmU7n_ F16 (&sAlphaBeta, &sAbc);

2.14 GMCLIB_SvmDpwm

The GMCLIB_SvmDpwmfunction calculates the appropriate duty-cycle ratios needed for the generation of the given stator-
reference voltage vector using the general non-sinusoidal modulation technique. The GMCLIB_SvmDpwmfunction is a subset of
the GMCLIB_SvmExDpwmfunction and includes a power factor angle input. Both functions are identical if ¢ = 0.

The GMCLIB_SvmDpwm function belongs to the discontinuous PWM modulation techniques for 3-phase voltage inverters. The
advantages of the discontinuous PWM technique are lower switching loses, but, on the other hand, it can cause higher harmonic
distortion at low modulation indexes. The current sensing at low modulation indexes is more complicated and less precise when
compared with the symmetrical modulation techniques like GMCLIB_SvmStd. Therefore, the discontinuous and continous SVM
are usually combined together.

Finding the sector in which the reference stator voltage vector Ug resides is similar to GMCLIB_SvmStd. This is achieved
by converting the direct-a and quadrature-3 components of the reference stator voltage vector Ug into the balanced 3-phase
quantities Uef1, Urer2, and Uerz Using the modified Inverse Clarke transformation:

Uref1= Up
\E U Up
Upe 12 = 2
~\3ugup
Upef3= 2

The sector calculation is based on comparing the 3-phase reference voltages Urefq, Uref2, and Ugess With zero. This computation is
described by the following figure:
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/\

Uref3 < 0 Uref3 > 0
Uref2 > 0 Uref2 = 0 Uref2 > 0 Uref2 < 0
Uref1 = 0 Ureft = 0 Uref1 = 0 Uref1 > 0
Sector = VI Sector =1 Sector =1l Sector =V Sector = IV Sector = Il

Figure 56. Identification of the sector number

The knowledge of the sector is necessary for the current sensing especially when shunt resistors are used. The
GMCLIB_SvmDpwmfunction does not require the sector directly, but it requires the portion identification explained in the
following. The Inverse Clarke transformation converts the ug, ug voltage components of the reference stator voltage vector Us to
3-phase voltage components u,, up, and u.. The portion identification selects the portion from the u,, u,, and u. voltages, based
on the following conditions.

ua*EU Ua*‘(O
ue* < 0 ue* = 0 u* < 0 us* =
u* =0 u* <0 u* =0 u* <0

Partion =l/] Partion=] Partion=]] Partion=V Partion=]JV Partion=]]]

Figure 57. Identification of the portion number

Finally, the corresponding duty cycle is selected according to the portion from the column of the following table.

Table 20. Duty cycle calculation from portions

Portions | Il ] [\ \' Vi

Voltage Us30,.U30 Us0,Ug0 Ugo,U150 U1s0.U210 U210.Uz270 Uz70.Us30
boundaries

pwm_a 1 0 - Urers 1+ Urera 0 1 - Urefs 0 + Ure2

pwm_b 1 - Uref2 0 + Urert = Ug 1 0 - Urerp 1+ Ut =1+ Ug 0

pwm_c 1+ Upefs 0 1-Upef1 =1-ug 0 + Urefs 1 0-Uer1 =0-up

2.14.1 Available versions
This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmDpwm function are shown in the following table:

GMCLIB User's Guide, Rev. 5, 01 November 2021
User Guide 75/98




NXP Semiconductors

Algorithms in detail

Table 21. Function versions

Function name Input type Output type Result type

GMCLIB_SvmDpwm_F1 | GMCLIB_2COOR_ALBE_T_F16 * GMCLIB_3COOR_T_F16 * uint16_t
6

Standard discontinuous PWM with a 16-bit fractional stationary (a-f) input, and a 16-bit fractional
3-phase output. The result type is a 16-bit unsigned integer, which indicates the actual SVM sector.
The input is within the range <-1; 1); the output duty cycle is within the range <0 ; 1). The output
sector is an integer value within the range <1 ; 6>.

2.14.2 Declaration

The available GMCLIB_SvmDpwm functions have the following declarations:

uintl6_t GMCLIB_ SvmDpwm F16 (const GMCLIB 2COOR ALBE T F16 *psIn, GMCLIB 3COOR T F16 *psOut)

2.14.3 Function use

The use of the GMCLIB_SvmDpwm function is shown in the following example:

#include "gmclib.h"

static uintl6é t ul6Sector;
static GMCLIB 2COOR ALBE T F16 sAlphaBeta;
static GMCLIB 3COOR T F16 sAbc;

void Isr (void) ;

void main (void)

{
/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

/* Periodical function or interrupt */

}
void Isr (void)

/* Standard Discountinues PWM SVM calculation */
ul6Sector = GMCLIB SvmGenDpwm F16 (&sAlphaBeta, &sAbc);

2.15 GMCLIB_SvmExDpwm

The GMCLIB_SvmExDpwmfunction calculates the appropriate duty-cycle ratios needed for the generation of the given stator-
reference voltage vector using the general non-sinusoidal modulation technique. The GMCLIB_SvmExDpwmfunction is a
superset of the GMCLIB_SvmDpwmfunction without the power factor angle input.

The GMCLIB_SvmExDpwm function belongs to the discontinuous PWM modulation techniques for a 3-phase voltage inverter.
The advantages of the discontinuous PWM technique are lower switching loses, but, on the other hand, it can cause higher
harmonic distortion at low modulation indexes. The current sensing at low modulation indexes is more complicated and less
precise when compared to the symmetrical modulation techniques like GMCLIB_SvmStd. Therefore, the discontinuous and
continuous SVM are usually combined together.
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Finding the sector in which the reference stator voltage vector Ug resides is similar to GMCLIB_SvmStd. This is achieved
by converting the direct-a and quadrature-f components of the reference stator voltage vector Ug into the balanced 3-phase
quantities Urefq, Uref2, and Ugerz Using the modified Inverse Clarke transformation:

Upef1= Up
\I?: UgUp
Upe 12 = 2
~\3ugup
Upef3= 2

The sector calculation is based on comparing the 3-phase reference voltages Uyefq, Urefo, @and Uesz With zero. This computation is
described by the following figure:

/\

Uref3 < 0 Urer3 > 0
Urer2 > 0 Uref2 < 0 Uref2 > 0 Uref2 < 0
Uref1 < 0 Ureft > 0 Uref1 < 0 Uref1 > 0
Sector = VI Sector=| Sector =1l Sector =V Sector = IV Sector = Il

Figure 58. Identification of the sector number

The knowledge of the sector is necessary for the current sensing especially when shunt resistors are used. The
GMCLIB_SvmExDpwmfunction does not require the sector directly, but it requires the portion identification explained in following
text. The Park transformation uses the phase shift of the generated phase voltages and currents - ¢ angle to rotate the reference
stator voltage vector Ug to Ug* with the ug*, ug* components. The inverse Clarke transformation converts the uy*, ug* voltage
components to 3-phase voltage components u,*, uy*, and u.*. The portion identification selects the portion from the u,*, up*, and
u.* voltages based on the following conditions.

u== 0 us < 0
us< ue = 0 Ue < 0 Ue = ()
uc= 0 Ue<< 0 Uc = () ue<< 0

Partion =l/] Partion=] Partion=]] Partion=V Partion=]}/ Partion=][]]

Figure 59. Identification of the portion number

Finally, the corresponding duty cycle is selected according to the portion from the column of the following table.

Table 22. Duty cycle calculation from portions

Portions | Il 1 \Y} \ VI

Voltage Uazo,Uszg Uso,Ugo Ugo,U1s0 U1s0,U210 Uz10,.U270 Uz70,Us30
boundaries

pwm_a 1 0 - Urers 1+ Urera 0 1 - Urefs 0 + Urer2

Table continues on the next page...
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pwm_b

1 - Ure2

0+ Ut = U

1

0 - Uero

T+ Upe=1+ug

pwm_c

1+ Urera

0

1-Uper =1-Ug

0+ Urers

0-Uer1=0-ug

2.15.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmExDpwm function are shown in the following table:

Table 23. Function versions

Function name

Input type

Output type

Result type

F16

GMCLIB_SvmExDpwm_

GMCLIB_2COOR_ALBE_T_F16 *

GMCLIB_2COOR_SINCOS_T_F16 *

GMCLIB_3COOR_T_F16 *

uint16_t

Extended discontinuous PWM with a 16-bit fractional stationary (a-g) input, the second input using a
16-bit fractional (sin(¢) / cos(@)) structure of ¢ angle (-1/6 ; 1/6) in fraction corresponding (-11/6 ; 11/6)
in radians - angle of the power factor, it is a phase shift of the generated phase voltages and currents
and a 16-bit fractional 3-phase output. The result type is a 16-bit unsigned integer which indicates

the actual SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range
<0 ; 1). The output sector is an integer value within the range <1 ; 6>.

2.15.2 Declaration

The available GMCLIB_SvmExDpwm functions have the following declarations:

uintl6_t GMCLIB SvmExDpwm F16 (const GMCLIB_ 2COOR ALBE T F16 *psIn,const GMCLIB 2COOR_SINCOS T F16
*psAngle, GMCLIB 3COOR T F16 *psOut)

2.15.3 Function use

The use of the GMCLIB_SvmExDpwm function is shown in the following example:

static
static
static
static

{

#include "gmclib.h"

uintl6é_t ulé6Sector;
GMCLIB 2COOR ALBE T F16 sAlphaBeta;
GMCLIB_2COOR_SINCOS T F16 sAlphaBeta;
GMCLIB 3COOR T F16 sAbc;

void Isr(void) ;
void main (void)

/* Alpha, Beta structure initialization */
sAlphaBeta.fl6Alpha = FRAC16(0.0);
sAlphaBeta.fl6Beta = FRAC16(0.0);

/* Power factor angle structure initialization */
sAngle.fl6Cos = FRAC16(1.0);
sAngle.f16Sin = FRAC16(0.0);
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/* Periodical function or interrupt */
void Isr(void)
{
/* Extended Discountinues PWM calculation */
ul6Sector = GMCLIB SvmExDpwm F16 (&sAlphaBeta, &sAngle, &sAbc);
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A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two states: TRUE (1) or FALSE (0). Its definition
is as follows:

typedef unsigned short bool t;

The following figure shows the way in which the data is stored by this type:

Table 24. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value Unused Logi

cal

TRUE Ol o|o|o0o|]o|O0O|]O|O|]O|O|]O|O/|]O]|oO]|]oO] 1
0 0 0 1

FALSE o|lo|o|lo|o|lo|]o|oOo|]O|O|]O|O|O|O|O|oO
0 0 0 0

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within the range <0 ; 255>. Its definition is
as follows:

typedef unsigned char uint8_t;

The following figure shows the way in which the data is stored by this type:

Table 25. Data storage

Value Integer

255 1 1 1 1 1 1 1 1

Table continues on the next page...
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Table 25. Data storage (continued)
11 0 0 0 1 1
0
124 0 1 1 1 0
7
159 1 0 0 1 1
9
A.3 uint16_t

The uint16_t type is an unsigned 16-bit integer type. It is able to store the variables within the range <0 ; 65535>. Its definition is

as follows:

typedef unsigned short uintlé6 t;

The following figure shows the way in which the data is stored by this type:

Table 26. Data storage

15 14 13 12 1" 10 7 0
Value Integer

65535 1 1 1 1 1 1 1 1
F

5 0 0 0 0 0 0 0 1
0

15518 0 0 1 1 1 1 1 0
3

40768 1 0 0 1 1 1 0 0
9
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Library types

The uint32_t type is an unsigned 32-bit integer type. Itis able to store the variables within the range <0 ; 4294967295>. Its definition

is as follows:

typedef unsigned long uint32 t;

The following figure shows the way in which the data is stored by this type:

Table 27. Data storage

31 24 23 16 15 7 0
Value Integer
4294967295 F F F F
2147483648 8 0 0 0
55977296 0 3 2 0
3451051828 C D D 4
A.5 int8_t

The int8_t type is a signed 8-bit integer type. It is able to store the variables within the range <-128 ; 127>. Its definition is as follows:

typedef char int8 t;

The following figure shows the way in which the data is stored by this type:

Table 28. Data storage

Table continues on the next page...
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7 6 5 3 0
Value Sign Integer

127 0 1 1 1 1
7

-128 1 0 0 0 0
8

60 0 0 1 1 0
3
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Table 28. Data storage (continued)

-97 1 0 0 1 1 1 1 1

A.6 int16_t

The int16_t type is a signed 16-bit integer type. It is able to store the variables within the range <-32768 ; 32767>. Its definition is
as follows:

typedef short intl6 t;

The following figure shows the way in which the data is stored by this type:

Table 29. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Value Sign Integer
32767 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 F F F
-32768 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 0 0 0
15518 0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0
3 Cc 9 E
-24768 1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0
9 F 4 0
A.7 int32_t

The int32_t type is a signed 32-bit integer type. It is able to store the variables within the range <-2147483648 ; 2147483647>. Its
definition is as follows:

typedef long int32 t;

The following figure shows the way in which the data is stored by this type:

Table 30. Data storage

Table continues on the next page...
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Table 30. Data storage (continued)
31 24 23 16 15 8 7 0
Value S Integer
2147483647 7 F F F F F F F
-2147483648 8 0 0 0 0 0 0 0
55977296 0 3 5 6 2 5 5 0
-843915468 C D B 2 D F 3 4
A.8 frac8_t

The frac8_t type is a signed 8-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:
typedef char frac8 t;

The following figure shows the way in which the data is stored by this type:

Table 31. Data storage

7 6 5 4 3 2 1 0
Value Sign Fractional
0.99219 0 1 1 1 1 1 1 1
7 F
-1.0 1 0 0 0 0 0 0 0
8 0
0.46875 0 0 1 1 1 1 0 0
3 C
-0.75781 1 0 0 1 1 1 1 1
9 F

To store a real number as frac8_t, use the FRAC8 macro.
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A.9 frac16_t

The frac16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is
as follows:

typedef short fraclé6 t;

The following figure shows the way in which the data is stored by this type:

Table 32. Data storage

%5 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Value Sign Fractional
0.99997 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 F F F
-1.0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 0 0 0
0.47357 0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0
3 Cc 9 E
-0.75586 1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0
9 F 4 0

To store a real number as frac16_t, use the FRAC16 macro.

A.10 frac32_t

The frac32_t type is a signed 32-bit fractional type. It is able to store the variables within the range <-1; 1). Its definition is
as follows:

typedef long frac32 t;

The following figure shows the way in which the data is stored by this type:

Table 33. Data storage

31 24 23 16 15 8 7 0

Value S Fractional

0.9999999995

~
M

F F F F F F

Table continues on the next page...
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Table 33. Data storage (continued)

Library types

-1.0 8 0 0 0 0
0.02606645970 0 3 5 6 2
-0.3929787632 Cc D B 2 D

To store a real number as frac32_t, use the FRAC32 macro.

A.11 acc16_t

The acc16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-256 ; 256). Its definition is

as follows:
typedef short accl6 t;

The following figure shows the way in which the data is stored by this type:

Table 34. Data storage

15 14 13 12 11 10 9 8 7 6 5 3
Value Sign Integer Fractional

255.9921875 0 1 1 1 1 1 1 1 1 1 1 1
7 F F

-256.0 1 0 0 0 0 0 0 0 0 0 0 0
8 0 0

1.0 0 0 0 0 0 0 0 0 1 0 0 0
0 0 8

-1.0 1 1 1 1 1 1 1 1 1 0 0 0
F F 8

13.7890625 0 0 0 0 0 1 1 0 1 1 1 0
0 6 E

-89.71875 1 {10 1]{o]o |11 |]0]|o0]1 0
D 3 2
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To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables within the range <-65536 ; 65536). Its
definition is as follows:

typedef long acc32 t;

The following figure shows the way in which the data is stored by this type:

Table 35. Data storage

31 24 23 16 15 8 7 0

Value S Integer Fractional
65535.999969 7 F F F F F F F
-65536.0 8 0 0 0 0 0 0 0
1.0 0 0 0 0 8 0 0 0
-1.0 F F F F 8 0 0 0
23.789734 0 0 0 B E 5 1 6
-1171.306793 F D B 6 5 8 B c

To store a real number as acc32_t, use the ACC32 macro.

A.13 float_t

The float_t type is a signed 32-bit single precision floating-point type, defined by IEEE 754. It is able to store the full precision
(normalized) finite variables within the range <-3.40282 - 1038 ; 3.40282 - 1038) with the minimum resolution of 2-23, The smallest
normalized number is £1.17549 - 10-38. Nevertheless, the denormalized numbers (with reduced precision) reach yet lower values,
from £1.40130 - 1045 to £1.17549 - 1038, The standard also defines the additional values:

* Negative zero
* Infinity
» Negative infinity
* Not a number
The 32-bit type is composed of:
« Sign (bit 31)
» Exponent (bits 23 to 30)
* Mantissa (bits 0 to 22)

The conversion of the number is straighforward. The sign of the number is stored in bit 31. The binary exponent is decoded as
an integer from bits 23 to 30 by subtracting 127. The mantissa (fraction) is stored in bits 0 to 22. An invisible leading bit (it is not
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actually stored) with value 1.0 is placed in front; therefore, bit 23 has a value of 0.5, bit 22 has a value 0.25, and so on. As a result,
the mantissa has a value between 1.0 and 2. If the exponent reaches -127 (binary 00000000), the leading 1.0 is no longer used
to enable the gradual underflow.

The float_t type definition is as follows:
typedef float float t;

The following figure shows the way in which the data is stored by this type:

Table 36. Data storage - normalized values

31 24 23 16 15 8 7 0

Value S Exponent Mantissa

(20-22%-227 /o1 1111110111111 11111111111111111

= 3.40282 - 1038 7 F 7 F F F F F

(20-22-2271111 111111011111 111111111111111111

=-3.40282 - 1038 F F 7 F F F F F

2126 0Oloooooo0oo0'0000000000D0O0DO0O0ODO0OO0OO0OO0GO 0O

= 1.17549 - 10-38 0 0 8 0 0 0 0 0

-2°126 Tooo0oo0000'"000000000000O0O0O0DO0OO0OO0GO0TO0DO

=-1.17549 - 10-38 8 0 8 0 0 0 0 0

1.0 0lo11111117000000000000000000O00O00O0O0O

-1.0 "o1111117000000000000000000O00O0O0GO0O

h oj/1o00000091001001000011111101101 1

= 3.1415927 4 0 4 9 0 F D B

-20810.086 |11 0 0 0110 1/01000101001010000101100

Cc 6 A 2 9 4 2 Cc

Table continues on the next page...
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Table 36. Data storage - normalized values (continued)
Table 37. Data storage - denormalized values
31 24 23 16 15 87 0
Value S Exponent Mantissa
0.0 0Oloo0o000090000000000000O0O0O0O0O0O00O0O0O0O
0 0 0 0 0 0 0 0
-0.0 "oooo00009%90000000000000O0DO0O0OOO0O0O0O0TO0OQO
8 0 0 0 0 0 0 0

(10-22%.2"%/glo 00 00000(11111111111111111111111

~1.17549 - 10'38 0 0 7 F F F F F

(1.0-22%.2726/110 00000091111 1111111111111111111

= -1.17549 - 1038 8 0 7 F F F F F

2. 2126 0Olooo000001000000000000000O0O0O0O0GO0O0O

= 5.87747 - 10739 0 0 4 0 0 0 0 0

2127126 "o 0000000100000 00000000O0DO0O0O0O0O0O0O0DO

= -5.87747 - 103 8 0 4 0 0 0 0 0

223 . p-126 Oloooo0oo0000/000000000DO0O0ODO0OOOO0OOOO0OGOTO0 1

= 1.40130 - 1045 0 0 0 0 0 0 0 1

-2-28. 2-126 "o o00000090000000000000O00O0O0OO0OGO0O0O0 1

= -1.40130 - 1045 8 0 0 0 0 0 0 1
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31 24 23 16 15
Value S Exponent Mantissa
o 0/|1111111170000000000000000000O0GO0TG 0O
7 F 8 0 0 0 0
- M1 11111117M00000000000000000000000
F F 8 0 0 0 0
Notanumber | *1q4 1 9 1 1 1 1 1 non zero
7IF F 800001 to FFFFFF

A.14 GMCLIB_3COOR_T_F16

The GMCLIB_3COOR_T_F16 structure type corresponds to the three-phase stationary coordinate system, based on the A, B, and
C components. Each member is of the frac16_t data type. The structure definition is as follows:

typedef struct

{
fracle t f1l6A;
fracle t f16B;
fracle t fl16C;

} GMCLIB 3COOR T F16;

The structure description is as follows:

Table 39. GMCLIB_3COOR_T_F16 members description

Type Name Description
frac16_t f16A A component; 16-bit fractional type
frac16_t f16B B component; 16-bit fractional type
frac16_t f16C C component; 16-bit fractional type

A.15 GMCLIB_3COOR_T_FLT

The GMCLIB_3COOR_T_FLT structure type corresponds to the three-phase stationary coordinate system, based on the A, B, and
C components. Each member is of the float_t data type. The structure definition is as follows:

typedef struct

{
float t fltA;
float t f1tB;
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float t fl1tC;
} GMCLIB_3COOR_T_FLT;

The structure description is as follows:

Table 40. GMCLIB_3COOR_T_FLT members description

Type Name Description
float_t fltA A component; 32-bit single precision floating-point type
float_t fltB B component; 32-bit single precision floating-point type
float_t fltC C component; 32-bit single precision floating-point type

A.16 GMCLIB_2COOR_AB_T_F16

Library types

The GMCLIB_2COOR_AB_T_F16 structure type corresponds to the general two-phase stationary coordinate system, based on
the A and B orthogonal components. Each member is of the frac16_t data type. The structure definition is as follows:

typedef struct

{
fracle t f16A;
fracle t f16B;

} GMCLIB 2COOR AB T F16;

The structure description is as follows:

Table 41. GMCLIB_2COOR_AB_T_F16 members description

Type Name Description
frac16_t f16A A-component; 16-bit fractional type
frac16_t f16B B-component; 16-bit fractional type

A.17 GMCLIB_2COOR_AB_T_F32

The GMCLIB_2COOR_AB_T_F32 structure type corresponds to the general two-phase stationary coordinate system, based on
the A and B orthogonal components. Each member is of the frac32_t data type. The structure definition is as follows:

typedef struc

{
frac32 t £32Alpha;
frac32 t f32Beta;

} GMCLIB 2COOR AB T F32;

The structure description is as follows:

Table 42. GMCLIB_2COOR_AB_T_F32 members description

Type Name Description
frac32_t f32A A component; 32-bit fractional type
frac32_t f32B B component; 32-bit fractional type
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A.18 GMCLIB_2COOR_AB_T_FLT
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The GMCLIB_2COOR_AB_T_FLT structure type corresponds to the general two-phase stationary coordinate system, based on

the A and B orthogonal components. Each member is of the float_t data type. The structure definition is as follows:

typedef struct
{

float t fltAlpha;

float t fltBeta;

} GMCLIB 2COOR AB T FLT;

The structure description is as follows:

Table 43. GMCLIB_2COOR_AB_T_FLT members description

Type Name Description
float_t fltA B-component; 32-bit single precision floating-point type
float_t fltB B-component; 32-bit single precision floating-point type

A.19 GMCLIB_2COOR_ALBE_T_F16

The GMCLIB_2COOR_ALBE_T_F16 structure type corresponds to the two-phase stationary coordinate system, based on the

Alpha and Beta orthogonal components. Each member is of the frac16_t data type. The structure definition is as follows:

typedef struct
{

fraclé t fleéAlpha;
fracle_t fléBeta;
} GMCLIB 2COOR ALBE T F16;

The structure description is as follows:

Table 44. GMCLIB_2COOR_ALBE_T_F16 members description

Type Name Description
frac16_t f16Apha a-component; 16-bit fractional type
frac16_t f16Beta B-component; 16-bit fractional type

A.20 GMCLIB_2COOR_ALBE_T_FLT

The GMCLIB_2COOR_ALBE_T_FLT structure type corresponds to the two-phase stationary coordinate system based on the

Alpha and Beta orthogonal components. Each member is of the float_t data type. The structure definition is as follows:

typedef struct
{

float t fltAlpha;
float_t fltBeta;
} GMCLIB 2COOR ALBE T FLT;

The structure description is as follows:
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Table 45. GMCLIB_2COOR_ALBE_T_FLT members description

Type Name Description
float_t fltApha a-component; 32-bit single precision floating-point type
float_t fliBeta B-component; 32-bit single precision floating-point type

A.21 GMCLIB_2COOR_DQ_T_F16

The GMCLIB_2COOR_DQ_T_F16 structure type corresponds to the two-phase rotating coordinate system, based on the D and
Q orthogonal components. Each member is of the frac16_t data type. The structure definition is as follows:

typedef struct

{
fracle_t f16D;
fracle t £160Q;

} GMCLIB 2COOR DQ T F16;

The structure description is as follows:

Table 46. GMCLIB_2COOR_DQ_T_F16 members description

Type Name Description
frac16_t f16D D-component; 16-bit fractional type
frac16_t f16Q Q-component; 16-bit fractional type

A.22 GMCLIB_2COOR_DQ_T_F32

The GMCLIB_2COOR_DQ_T_F32 structure type corresponds to the two-phase rotating coordinate system, based on the D and
Q orthogonal components. Each member is of the frac32_t data type. The structure definition is as follows:

typedef struct

{
frac32_t £32D;
frac32 t £320;

} GMCLIB 2COOR DQ T F32;

The structure description is as follows:

Table 47. GMCLIB_2COOR_DQ_T_F32 members description

Type Name Description
frac32_t f32D D-component; 32-bit fractional type
frac32_t f32Q Q-component; 32-bit fractional type

A.23 GMCLIB_2COOR_DQ_T_FLT

The GMCLIB_2COOR_DQ_T_FLT structure type corresponds to the two-phase rotating coordinate system, based on the D and
Q orthogonal components. Each member is of the float_t data type. The structure definition is as follows:

typedef struct
{
float_t f1tD;
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float t f1tQ;

} GMCLIB 2COOR DQ T FLT;

The structure description is as follows:

Table 48. GMCLIB_2COOR_DQ_T_FLT members description

Type Name Description
float_t fltD D-component; 32-bit single precision floating-point type
float_t fltQ Q-component; 32-bit single precision floating-point type

A.24 GMCLIB_2COOR_SINCOS_T_F16

Library types

The GMCLIB_2COOR_SINCOS_T_F16 structure type corresponds to the two-phase coordinate system, based on the Sin and

Cos components of a certain angle. Each member is of the frac16_t data type. The structure definition is as follows:

typedef struct

{
fracle t f16Sin;
fracle _t fléCos;

} GMCLIB 2COOR SINCOS T F16;

The structure description is as follows:

Table 49. GMCLIB_2COOR_SINCOS_T_F16 members description

Type Name Description
frac16_t f16Sin Sin component; 16-bit fractional type
frac16_t f16Cos Cos component; 16-bit fractional type

A.25 GMCLIB_2COOR_SINCOS_T_FLT

The GMCLIB_2COOR_SINCOS_T_FLT structure type corresponds to the two-phase coordinate system, based on the Sin and

Cos components of a certain angle. Each member is of the float_t data type. The structure definition is as follows:

typedef struct

{
float t fltSin;
float t fltCos;

} GMCLIB 2COOR_SINCOS T FLT;

The structure description is as follows:

Table 50. GMCLIB_2COOR_SINCOS_T_FLT members description

Type Name Description
float_t fltSin Sin component; 32-bit single precision floating-point type
float_t fliCos Cos component; 32-bit single precision floating-point type
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A.26 FALSE

The FALSE macro serves to write a correct value standing for the logical FALSE value of the bool_t type. Its definition is as follows:

#define FALSE ((bool t)O0)

#include "mlib.h"
static bool t bval;
void main (void)

{
bval = FALSE; /* bval = FALSE */

A.27 TRUE

The TRUE macro serves to write a correct value standing for the logical TRUE value of the bool_t type. Its definition is as follows:

#define TRUE ((bool t)1)

#include "mlib.h"
static bool t bval;
void main (void)
{
bval = TRUE; /* bVal = TRUE */

A.28 FRACS8

The FRAC8 macro serves to convert a real number to the frac8_t type. Its definition is as follows:

#define FRAC8 (x) ((frac8 t) ((x) < 0.9921875 ? ((x) >= -1 ? (x)*0x80 : 0x80) : Ox7F))

The input is multiplied by 128 (=27). The output is limited to the range <0x80 ; 0x7F>, which corresponds to <-1.0 ; 1.0-27>.

#include "mlib.h"
static frac8 t f8val;
void main (void)

{
f8val = FRAC8(0.187); /* f8val = 0.187 */
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A.29 FRAC16
The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is as follows:
#define FRACL6 (x) ((fracl6 t) ((x) < 0.999969482421875 2 ((x) >= -1 2 (x)*0x8000 : 0x8000) : O0x7FFF))

The input is multiplied by 32768 (=215). The output is limited to the range <0x8000 ; 0x7FFF>, which corresponds to
<-1.0; 1.0-21%>,

#include "mlib.h"
static fraclé t flé6Val;
void main (void)

{
fléval = FRAC16(0.736); /* fléval = 0.736 */

A.30 FRAC32
The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is as follows:

#define FRAC32 (x) ((frac32 t) ((x) <1 ? ((x) > -1 ? (x)*0x80000000 : 0x80000000) : Ox7FFFFFFF))

The inputis multiplied by 2147483648 (=231). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds
to <-1.0; 1.0-2-31>.

#include "mlib.h"
static frac32 t f32val;
void main (void)

{
f32val = FRAC32(-0.1735667) ; /* £32val = -0.1735667 */

A.31 ACC16

The ACC16 macro serves to convert a real number to the acc16_t type. Its definition is as follows:
#define ACC16(x) ((accl6 t) ((x) < 255.9921875 2 ((x) >= -256 2 (x)*0x80 : 0x8000) : Ox7TFFF))

The input is multiplied by 128 (=27). The output is limited to the range <0x8000 ; 0x7FFF> that corresponds to
<-256.0 ; 255.9921875>.

#include "mlib.h"
static accl6_t aléval;

void main (void)

{

GMCLIB User's Guide, Rev. 5, 01 November 2021
User Guide 96 /98




NXP Semiconductors

Library types

alévVal = ACC16(19.45627); /* alé6val = 19.45627 */

A.32 ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as follows:

#define ACC32 (x) ((acc32 t) ((x) < 65535.999969482421875 ? ((x) >= -65536 2 (x)*0x8000 : 0x80000000)
O0x7FFFFFFF) )

The input is multiplied by 32768 (=219). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to
<-65536.0 ; 65536.0-21%>,

#include "mlib.h"
static acc32 t a32val;
void main (void)

{
a32Val = ACC32(-13.654437); /* a32val = -13.654437 */
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